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Chapter 1
Getting Started with ProbeMaster

About ProbeMaster
ProbeMaster is a graphical editor for generating tester download files for moving probe testers.
ProbeMaster allows you to automate most functions for maximum efficiency.

Importing PCB Data
ProbeMaster imports files in several formats:

• Import Lavenir Format 4 netlists and IPC-D-356 netlists.

• Import IPC356A.

• Import supplemental Gerber data such as silkscreen, soldermask, and board outline data for
the purpose of determining the accessibility of test points.

• Import FixMaster job files. This feature allows you to split nets out of a netlist in FixMaster,
generate a fixture for some of the nets in FixMaster, and set up the dense parts in ProbeMaster
for testing on a moving probe tester.

Editing PCB and Test Point Data
Once PCB data has been imported, you can edit a graphic representation of pads and test points. Use
the Reference Frame to include or exclude portions of the data for automatic group editing operations.
Inspect and edit netlist data all at once or one net at a time. You can automatically or manually perform
many functions:

• Move, rotate, and mirror PCB data.

• Specify the D Code size range and all other parameters for automatically generating test
points.

• Select a two-point or three-point stagger and D Code size range for automatically staggering
test points.

• Manually add, delete, move and stagger test points.

• Inspect and correct head collision errors.

• Check net adjacency.
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Exporting Data
ProbeMaster exports files for testing PCBs on moving probe testers. ProbeMaster exports the
following file types:

Exporting Tester Download Files
ProbeMaster exports tester download files for the following testers.

• MicroCraft MP-440 and Emma testers

• Probot/Mania

• Hummingbird

• AFT or ATG

• Probotech

ProbeMaster also exports IPC356A, which contains test information used by some testers and repair
stations.

Exporting Computer Aided Repair Files
ProbeMaster also exports CAR files for use in fault verification on some repair stations.

Saving ProbeMaster Job Files
ProbeMaster saves and opens ProbeMaster .JOB files, which contain all configuration and
environment variables for a ProbeMaster job: probe diameters, probe air gaps, probe margins, D Code
and probe mapping, and stagger and generate options. The file also contains the PCB database,
including pads and test points for both board sides.

.JOB files can be used as boilerplate files that can be saved and reloaded when you have similarly
configured jobs.

.JOB files of completed jobs can be loaded into Verify for fault verification.
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What's New in ProbeMaster 7.5 for Windows
Lavenir has added some new features to ProbeMaster 7.5 for Windows since the release of Version
6.3.

New Features
• New Support for IPC-356-A: Imports and exports a subset of IPC-356-A. Adds more

support for end of copper testing. Exports fiducial locations and coded step and repeats.

• Nidec/Read: More Nidec/Read support.

• Test Point Staggering: Adds a "random" option for staggering test points around through
holes which staggers test points randomly (up, down, left and right).

• Densely Packed Component Isolation: When a component is to be split out to be tested
separately and multiple test points of split out nets lie outside the component, then only one
test point outside the component needs to be kept with the split. The component isolation
feature makes for more efficient testing of split out components.

Send Us Your Comments
Lavenir is committed to continuous improvement. Your constructive comments on ProbeMaster will
help us to improve features of the software.

• Please e-mail your comments and suggestions regarding ProbeMaster to
feedback@lavenir.com.

• Visit the Lavenir Web Site at http://www.lavenir.com.

• You can reach Lavenir Technical Support at (925) 680-7400 between the hours of 8 AM and
5 PM Pacific Time.

• Lavenir is located at:
2440 Estand Way
Pleasant Hill, CA   94523
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Download ProbeMaster Updates
Lavenir will be making updated versions of ProbeMaster and updated Help files available to customers
who have a current maintenance agreement or warranty. You can download the current ProbeMaster
updates from the Lavenir Premier Support Web site.

To Download ProbeMaster Updates:
1. Have your User Name and Password ready before logging on to the Lavenir Premier Web

Site. Your User Name and Password are printed on your User Password Letter. If you do not
know your User Name and Password, call Lavenir at (925) 680-7400.

2. Go to the Lavenir Web Site at http://www.lavenir.com.

3. On the Site Map, click on Premier Support.

4. On the User Name and Password dialog, enter your User Name and Password.

5. Click on Software Library .

6. Follow the instructions to download the PROBEMASTER SETUP.EXE update file to your
system.

7. Double-click on the downloaded PROBEMASTER SETUP.EXE file on your system and
follow the setup instructions.

Lavenir Technical Support
You can reach Lavenir Technical Support by:

• Telephone: (925) 680-7400 between the hours of 8 AM and 5 PM Pacific Time.

• E-Mail: support@lavenir.com.

• Web Site:  http://www.lavenir.com

Contact Lavenir Customer support with questions about Lavenir hardware and software or to arrange
for training or maintenance.

Lavenir is located at:

2440 Estand Way
Pleasant Hill, CA   94523
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Chapter 2
How to Process a Job Using ProbeMaster

This chapter includes a general outline for beginning-to-end job processing in ProbeMaster. It also lists
some commonly used features that do not belong in the step-by-step outline and some special features
that are unique to some test methods or testers.

Processing a Job Step-by-Step
This is a general outline for beginning-to-end job processing in ProbeMaster. Very few real-life jobs
will follow this outline exactly. Once you have used ProbeMaster for a while, most jobs will skip the
configuration setups and begin with opening a boilerplate .JOB file, then importing the PCB data. Use
this outline as a guide to the steps in a typical job and as a way to find more detailed information.

To Process a Job Using ProbeMaster:
1. If you have previously saved tester and operation configurations, open the boilerplate job.

See Opening a ProbeMaster Job File on page 139.

2. Set the tester configuration settings. See Setting up the Tester Configuration on page 47.

3. Import the PCB data. See Importing PCB Files into the Job on page 145.

4. Position the PCB data. See Positioning the PCB on page 51.

5. Identify the power and ground nets. See Identifying Power and Ground Plane Nets on page
63.

6. Map the D Codes to Probe Codes. See Mapping D Codes to Probe Codes on page 65.

7. Generate test points. See Adding Test Points on page 71.

8. Inspect possibly probeable, possibly covered points not given test points. See Possibly
Probeable, Possibly Covered Test Points on page 80.

9. Stagger test points. See Staggering Test Points on page 93.

10. Inspect and correct collision errors. See Checking for Collision Errors on page 105.

11. Inspect nets one at a time and edit test points in Netlist Inspection mode. See Netlist
Inspection Mode on page 109.

12. Generate adjacency data and inspect adjacent nets. See Net Adjacency on page 123.

13. Tag and inspect fiducials. See Fiducial Points on page 129.

14. Export the Files. See Exporting Tester Download Files on page 152 and the other export
procedure in File Handling in ProbeMaster on page 137.
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Additional Features Used in Most Jobs
In addition to those steps in the outline that are typically performed in a step-by-step order, this manual
covers additional features that are often used but don’t have a particular place in the outline:

• Viewing Data. See Viewing Data in ProbeMaster on page 15.

• Editing PCB data. See Editing PCB Data on page 163.

• Printing . See Printing in ProbeMaster on page 175.

• Automation. See Automatic Job Processing Features on page 179.

Special Features Unique to Some Test Methods
This manual also covers some special features that are unique to certain types of testers or test methods
and are not included in the general outline:

• Renumber Nets. See Renumbering Nets with Unique Net Numbers on page 183

• Soft Landing. See Soft Landing for MicroCraft Testers on page 184.

• The SMD Both Command. See SMD Both Command on page 185.

• Mark nets for separate export with the Selective Netlist command. See Marking Nets for
Separate Export on page 186.
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Chapter 3
ProbeMaster Interface Overview

ProbeMaster has a point-and-click Windows interface with most functions available on command
menus and command toolbars. Many functions can also be activated using shortcut key commands.
This chapter provides a brief overview of the major elements of the interface. For more detailed
descriptions of the commands represented on the individual menus and toolbar buttons, see the
sections of this manual that describe the function you want to perform.

Application Window

ProbeMaster Application Window

The ProbeMaster Application Window has command menus at the top, toolbars around the edges, a
status bar at the bottom and the viewing area in the center.
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Command Menus
Most commands in ProbeMaster can be accessed through the command menus. Command menus are
usually accessed by clicking on the command. In this manual, command menu commands are written
in bold and the cascade menus are separated by a dash ( - ).

Command Menu Instruction Example:
� On the Edit  menu, click PCB Data-Transcode-D Code.

The instruction in the example means to click the menu shown in the following graphic.

Command Menu Example

Access Keys for Menu Commands
Command menus can also be accessed from the keyboard using what are sometimes called access keys
or accelerator keys. The underlined character in each menu indicates the access key for that menu
selection. To use the access keys press the Alt  key and the first access key indicated in the top-level
menu. The menu drops down. Then press the other access keys indicated in each cascade menu.

Access Key Example:
1. For the example shown in the Command Menu Example graphic, press Alt+E  together.

The Edit Menu drops down.

2. Press P.

The PCB Data cascade menu drops down.

3. Press T.

The Transcode cascade menu drops down.

4. Press O.

The D Code command is selected.
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Shortcut Keys for Menu Commands
Often a command on the command menus will have an even faster way to access the command by
keyboard. These key commands are sometimes called shortcut keys or hotkeys. If there is an
equivalent key command, it is usually indicated on the final cascade menu. In the example in the
graphic, the shortcut key command is Ctrl+T . There are also shortcut keys for commands that are not
on the menus. For more about shortcut key commands see Key Commands on page 14. For a listing of
all shortcut key commands in ProbeMaster, see Key Commands Summary on page 189.

Command Toolbars
Many commands in ProbeMaster can be accessed through the command toolbars. Toolbar controls are
activated by clicking on the toolbar button or control. In this manual, toolbar controls are either shown
using a graphic, or the name of the button or control is written in bold.

To Find Out What a Toolbar Control Is:
� Hold the cursor over the toolbar button or control for a moment.

A ToolTip pops up next to the control. The ToolTip gives the name of the control and usually also
gives the equivalent key command. The Message Line in the Status Bar gives some additional
information about the control.

The following sections provide brief descriptions of each of the toolbars. For more detailed
descriptions of the toolbar commands, see the sections of this manual that describe the function you
want to perform.

Main Toolbar

Main Toolbar

The Main  toolbar has the File menu commands common to most Windows programs: New File, Open
File and Save File. It also has the Print  command.
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Action Toolbar
The Action toolbar has the high-level commands for automatic features, configuration dialogs and
entering Netlist Inspection and Adjacency Inspection modes.

Action Toolbar

Editing Toolbar

Editing Toolbar

The Editing  toolbar has commands for editing different types of elements. The Editing  toolbar and the
Editing Mode toolbar are used together. The kind of element that can be edited (pad or test point) and
the type of commands available on the Editing Toolbar  depend on the editing mode selected on the
Editing Mode toolbar. See Editing Mode Toolbar on page 11.
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Editing Mode Toolbar

Editing Mode Toolbar

The Editing Mode toolbar and the Editing  toolbar are used together. The Editing Mode toolbar
determines which types of elements can be edited by the commands on the Editing  toolbar, and it
determines which commands are available on the Editing  toolbar. See also Editing Toolbar on page
10.

Editing Mode Example:

� To edit PCB data using the Editing  toolbar, first click the Pad Editing Mode  button on
the Editing Mode toolbar.

The PCB Data Editing Mode is selected and now the Editing  toolbar buttons represent commands
that affect PCB data only. For instance the Insert button on the Editing  toolbar inserts pads.

� To edit test points using the Editing  toolbar, first click the Test Point Editing Mode 
button on the Editing Mode toolbar.

The Test Point Editing Mode is selected and now the Editing  toolbar buttons represent commands
that affect test points only. For instance the Insert button on the Editing  toolbar inserts test
points.

Note: The Editing Mode toolbar only affects the editing mode for commands on the Editing toolbar.
Editing commands that appear on the command menus do not require you to set the editing
mode first.

Goto Toolbar

Goto Toolbar

The Goto toolbar has commands for going to specific types of elements and test point errors.



ProbeMaster User’s Guide

12

HiLite Toolbar

HiLite Toolbar

The HiLite  toolbar has commands for highlighting specific types of elements.

Screen Toolbar

Screen Toolbar

The Screen toolbar has controls for changing the view of the Viewing Area and changing how the
cursor coordinates and distance are shown.
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Visibility Toolbar

Visibility Toolbar

The Visibility  toolbar has buttons that control what is shown on screen.

Status Bar

Status Bar

The Status Bar provides information about the selected elements and displays messages from the
system, such as prompts for commands.
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Key Commands
Many commands in ProbeMaster can be accessed through the keyboard using the key commands. For
a complete list of all shortcut keys in ProbeMaster, see Key Commands Summary on page 189.

Shortcut Key Commands
Shortcut keys are the fastest way to activate commands. Shortcut keys are usually a single keyboard
key (such as R or D), or they can use the Shift or Ctrl  keys modifiers (such as Shift+R or Ctrl+R ).

To Find the Shortcut Key for a Menu Command:
� Go to the menu command that you want to use.

If there is a shortcut key for that command, it will be indicated on the final cascade menu.

To Find the Shortcut Key for a Toolbar Control:
� Hold the cursor over the toolbar button or control for a moment.

A ToolTip pops up next to the control. If there is a shortcut key for that command, it will be
indicated on the ToolTip.

Access Key Commands
Access keys are just an alternative way to activate a menu command. The underlined character in each
menu indicates the access key for that menu selection. To use the access keys press the Alt  key and the
first access key indicated in the top-level menu, and then press the other access key indicated in each
cascade menu. For more about access keys, see Access Keys for Menu Commands on page 8.
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Chapter 4
Viewing Data in ProbeMaster

ProbeMaster has many options for viewing data. You can choose what data to display on screen,
highlight certain types of data, zoom up and down, go to specific locations or types of data, use an on-
screen positioning grid, measure distance and display job statistics.

Choosing What Data to Display
ProbeMaster has many commands that allow you to control what data is displayed on screen.

Displaying Component Side or Solder Side Data
You can choose which side of the board to display, either the component side or the solder side. Many
commands only work on the active board side. The currently active side is shown in the Status Bar,
either CMP or SOL.

To Display Component Side or Solder Side Data:
1. On the View menu, go to Active Side and look at Component Side and Solder Side.

• If Component Side has a checkmark next to it, then the Component Side data is being
displayed.

• If Solder Side has a checkmark next to it, then the Solder Side data is being displayed.

2. Click the either Component Side or Solder Side to select that side for display.

Menu: View-Active Side-Component Side or Solder Side

Button:

Key: Shift+O

Displaying the PCB Data
You can choose to display or not to display the imported PCB data.

To Display the PCB Data:
1. On the View menu, go to Data Elements and look at PCB.

• If PCB has a checkmark next to it, then the PCB data is being displayed.

• If PCB has no checkmark next to it, then the PCB data is not being displayed.

2. Click PCB to switch between displaying or not displaying the PCB data.

Menu: View-Data Elements-PCB

Button: None

Key: B
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Displaying All Pads or Only Pads with Test Points
When the PCB data is being displayed you can choose to display all pads or only pads that have test
points on them.

To Display All Pads or Only Pads with Test Points:
1. On the View menu, go to Data Elements-Pads and look at All .

• If All  has a checkmark next to it, then all pads are being displayed.

• If All  has no checkmark next to it, then only the pads with test points are being
displayed.

2. Click All  to switch between displaying all pads or only pads with test points.

Menu: View-Data Elements-Pads-All

Button:

Key: Shift+P

Displaying “Commented” Pads in IPC-D-356 Data
This command displays the “commented” pads in IPC-D-356 data. These are elements in which a letter
C has been inserted into the data to indicate that the element is “commented out.”

To Display “Commented” Pads in IPC-D-356 Data:
1. On the View menu, go to Data Elements-Pads and look at Commented.

• If Commented has a checkmark next to it, then the “commented” pads in IPC-D-356
data are being displayed.

• If Commented has no checkmark next to it, then the “commented” pads in IPC-D-356
data are not being displayed.

2. Click Commented to switch between displaying and not displaying the “commented” pads in
IPC-D-356 data.

Menu: View-Data Elements-Pads-Commented

Button: None

Key: None
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Displaying Only “Accessed” Side for IPC-D-356 with Access Data
Some IPC-D-356 files contain access data indicating which board side a given pad is to be accessed
from.

To Display Only the Accessed Side for IPC-D-356 Pads with Access Data:
1. On the View menu, go to Data Elements-Pads and look at Access.

• If Access has a checkmark next to it, then pads in IPC-D-356 data that have access
information are displayed only for the board side where they can be accessed.

• If Access has no checkmark next to it, then even pads in IPC-D-356 data that have
access information are displayed for both board sides, even if they can only be accessed
from one side.

2. Click Access to switch between displaying pads that have access information only on the
accessed board side and displaying those pads on both board sides.

Menu: View-Data Elements-Pads-Access

Button: None

Key: None

Displaying Net Numbers
ProbeMaster can display the net number of each pad next to each pad.

To Display Net Numbers:
1. On the View menu, go to Data Elements and look at Net Numbers.

• If Net Numbers has a checkmark next to it, then the net numbers are being displayed.

• If Net Numbers has no checkmark next to it, then the net numbers are not being
displayed.

2. Click Net Numbers to switch between displaying or not displaying the net numbers.

Menu: View-Data Elements-Net Numbers

Button:

Key: F
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Displaying Traces
When the PCB data is being displayed, you have several options for how to display traces, and you
have the option to not display them at all. Traces must be present in the imported PCB data in order to
be displayed.

To Display Traces:
1. On the View menu, click Data Elements-Trace.

2. In the Traces group box, select an option for which traces to display, if any:

• Hide All:  When this option is selected, no traces are displayed.

• Show Current Layer Plus Inner: When this option is selected, the traces for the active
board side, component or solder, are displayed, and the traces for the inner layers are also
displayed.

• Show Current Layer: When this option is selected, the traces for the active board side,
component or solder, are displayed.

3. In the Turn Off Traces with Net table, enter any net numbers for which you want to turn off
the display of traces. This option only has meaning if you have selected an option that
displays traces.

4. Click OK .

Menu: View-Data Elements-Trace

Button:    This button is a shortcut that switches between showing no traces and showing the
traces in the active board side, CMP or SOL.

Key: T:  This key displays the Show Trace dialog.
Shift+T: This key is a shortcut that switches between showing no traces and showing the
traces in the active board side, CMP or SOL.
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Displaying Silkscreen Data
If you have imported a silkscreen data file, you can choose to display or not to display the silkscreen
data. For information on importing silkscreen data, see Importing Supplemental Gerber Files into the
Job on page 150.

To Display Silkscreen Data:
1. On the View menu, go to Data Elements and look at Silkscreen.

• If Silkscreen has a checkmark next to it, then silkscreen data is being displayed.

• If Silkscreen has no checkmark next to it, then silkscreen data is not being displayed.

2. Click Silkscreen to switch between displaying or not displaying silkscreen data.

Menu: View-Data Elements-Silkscreen

Button:

Key: K

Displaying Soldermask Data
If you have imported a soldermask data file, you can choose to display or not to display the soldermask
data. For information on importing soldermask data, see Importing Supplemental Gerber Files into the
Job on page 150.

To Display Soldermask Data:
1. On the View menu, go to Data Elements and look at Soldermask.

• If Soldermask has a checkmark next to it, then soldermask data is being displayed.

• If Soldermask has no checkmark next to it, then soldermask data is not being
displayed.

2. Click Soldermask to switch between displaying or not displaying soldermask data.

Menu: View-Data Elements-Soldermask

Button:

Key: None
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Displaying Board Outline Data
If you have imported a board outline data file, you can choose to display or not to display the board
outline data. For information on importing board outline data, see Importing Supplemental Gerber
Files into the Job on page 150.

To Display Board Outline Data:
1. On the View menu, go to Data Elements and look at Board Outline.

• If Board Outline has a checkmark next to it, then board outline data is being displayed.

• If Board Outline has no checkmark next to it, then board outline data is not being
displayed.

2. Click Board Outline to switch between displaying or not displaying board outline data.

Menu: View-Data Elements-Board Outline

Button:

Key: O

Displaying Test Point Numbers
Each test point is assigned a unique test point number when the test files are exported. Most moving
probe testers report faults between test point numbers (i.e., a short between test points 14 and 25).
ProbeMaster can display the test point number of each pad next to each pad. ProbeMaster also has a
command that allows you to go to a specific test point number. See Going to a Test Point Number on
page 35.

To Display Test Point Numbers:
1. On the View menu, go to Data Elements and look at Test Number.

• If Test Number has a checkmark next to it, then the test point numbers are being
displayed.

• If Test Number has no checkmark next to it, then the test point numbers are not being
displayed.

2. Click Test Number to switch between displaying or not displaying the test point numbers.

Note: If all the test point numbers appear to be zero, it is because the test files have not been
exported yet. The test point numbers are generated when the data is exported.

Menu: View-Data Elements-Test Number

Button:

Key: None
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Displaying Fiducials
ProbeMaster has a command for displaying fiducials. For information on tagging fiducial locations,
see Fiducial Points on page 129.

To Display Fiducials:
1. On the View menu, click Data Elements-Fiducials.

ProbeMaster displays the same Fiducials table that is displayed when you set up fiducials;
however, on this dialog you do not have the option to tag the fiducials manually.

Fiducials Dialog

2. If the fiducial locations are correct, click OK . If they are not correct, enter the new locations
and click OK .

Each fiducial is displayed as a large magenta X.

Menu: View-Data Elements-Fiducials

Button: None

Key: None
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Highlighting Data on Screen
ProbeMaster has several highlighting commands to help you find certain types of data elements on
screen. These commands cause the particular type of data element to be displayed in magenta on
screen. Once data is highlighted, ProbeMaster also has a command for inspecting each highlighted
element in sequence. See Going to the Next Highlighted Element on page 34.

Showing Everything in Gray Except for the Highlighted Elements
ProbeMaster can make it easier to inspect the highlighted data by displaying everything in gray except
for the highlighted data.

To Show Everything in Gray Except for the Highlighted Elements:
1. On the View menu, click Data Elements-Net Exclusive.

All data elements on screen turn gray.

2. Activate the highlighting command you want to use.

The highlighted elements are shown in magenta and all other elements remain gray.

3. To restore the elements to normal color, go back to the View menu and click Data Elements-
Net Exclusive again.

Menu: View-Data Elements-Net Exclusive

Button: None

Key: None
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Highlighting a Specific Net
You can highlight a specific net.

To Highlight a Specific Net:
1. On the View menu, click Hi Lite Image-By Netlist.

ProbeMaster prompts for a net number.

Highlight Net

2. On the Net dialog, enter the number of the net you want to highlight and click OK .

ProbeMaster displays the net highlighted in magenta.

Menu: View-Hi Lite Image-By Netlist

Button:

Key: Shift+F
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Highlighting the Net of a Selected Element
You can highlight the net of a selected element.

To Highlight the Net of a Selected Element:

1. On the HiLite  Toolbar, click the Show Netlists button .

2. Click on the element in the net that you want to highlight.

The cursor snaps to the element and marks it with an X.

3. Click again.

ProbeMaster displays the net highlighted in magenta.

The Highlight Net of Element tool remains selected until you select another tool or press the
Escape key, so you can highlight one net after another by clicking on more elements.

Menu: None

Button:

Key: None
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Highlighting Data by D Code
You can highlight all the elements that have a selected D Code.

To Highlight Data by D Code:
1. On the View menu, click Hi Lite Image-By D Code.

ProbeMaster prompts for a D Code number.

Highlight D Code

2. On the D Code dialog, enter the D Code you want to highlight and click OK .

ProbeMaster displays the all elements of the selected D Code highlighted in magenta.

Menu: View-Hi Lite Image-By D Code

Button:

Key: Ctrl+D

Highlighting Tooling Holes
ProbeMaster has a command to highlight PCB data that has a D Code designated as representing
tooling holes in ProbeMaster. Tooling hole D Codes are not generally used in ProbeMaster, only in
FixMaster. Tooling hole D Codes are used in FixMaster to indicate D Codes in the PCB that are to be
transferred to the fixture and included in the drill output files. For more information on setting up
D Code types, including tooling holes, see Mapping D Codes to Probe Codes on page 65.

To Highlight Tooling Holes:
� On the View menu, click Hi Lite Image-By Tooling D Code.

ProbeMaster displays all data having a D Code mapped as a tooling hole highlighted in magenta.

Menu: View-Hi Lite Image-By Tooling D Code

Button:

Key: Shift+E
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Highlighting Data by Probe Code
You can highlight all the pads mapped to a selected Probe Code.

To Highlight Data by Probe Code:
1. On the View menu, click Hi Lite Image-By Probe Code.

ProbeMaster prompts for a Probe Code number.

Highlight Probe Code

2. On the Probe dialog, enter the Probe Code you want to highlight and click OK .

ProbeMaster displays the all elements mapped to the Probe Code highlighted in magenta.

Menu: View-Hi Lite Image-By Probe Code

Button: None

Key: Shift+B
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Highlighting Nets Marked with the Selective Nets Command
You can highlight all the nets that have been marked with the Selective Nets command. The Selective
Nets command allows you to mark special nets and export test files for those nets separate from the
rest of the loaded PCB data. For instance you could use Selective Nets to mark and test a ground
plane. For more information on marking nets with the Selective Nets command, see Marking Nets for
Separate Export on page 186. For information on exporting test files for the nets marked with the
Selective Nets command, see Exporting Tester Download Files on page 152.

To Highlight Marked Nets:
1. On the View menu, go to Data Elements and look at Selective.

• If Selective has a checkmark next to it, then nets marked with the Selective Nets
command are shown highlighted in magenta.

• If Selective has no checkmark next to it, then nets marked with the Selective Nets
command are not highlighted and are shown in their normal color.

2. Click Selective to switch between showing selective nets highlighted and not highlighted.

Menu: View-Data Elements-Selective

Button:

Key: None

Highlighting Soft Landing Pads
You can highlight all pads that have been designated as soft landing pads. For more information on
Soft Landing pads, see Soft Landing for MicroCraft Testers on page 184.

To Highlight Soft Landing Pads:
1. On the View menu, go to Data Elements and look at Soft Landing.

• If Soft Landing has a checkmark next to it, then pads that have been designated as soft
landing pads are shown highlighted in magenta.

• If Soft Landing has no checkmark next to it, then soft landing pads are not highlighted
and are shown in their normal color.

2. Click Soft Landing to switch between showing soft landing pads highlighted and not
highlighted.

Menu: View-Data Elements-Soft Landing

Button:

Key: None
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Removing Highlighting from the Screen
You can remove the highlighting from the screen and return all elements to their normal color.

To Remove Highlighting from the Screen:
� On the View menu, click Hi Lite Image-Remove Hi Lite.

ProbeMaster removes the magenta highlighting from any elements that are currently highlighted
and displays all elements in their normal colors.

Menu: View-Hi Lite Image-Remove Hi Lite

Button:

Key: Shift+H
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Zooming on Data
ProbeMaster has several commands for zooming up and down on the viewing area and zooming on
specific areas of the screen.

Zooming Up or Down in Steps
You can zoom up or down by a fixed amount.

To Zoom Up or Down:
� On the View menu, click Zoom-Zoom Up or Zoom Down.

ProbeMaster zooms the viewing area up or down, centered on the cursor position.

Note: It is usually preferable to run this command from the keyboard rather than the command
menus because you have more control over the cursor position when the command is
activated. This allows you to control the exact position to zoom on.

Menu: View-Zoom-Zoom Up or Zoom Down

Button:   Click the button, then click in the viewing area to Zoom Up.
No button for Zoom Down.

Key: Page Up key or Page Down key

Zooming to Show All Data
You can zoom so that all data fits in the screen.

To Zoom so that All Data is Shown on Screen:
� On the View menu, click Zoom-Zoom to Show All.

ProbeMaster zooms up or down so that all data on screen fits inside the viewing area.

Menu: View-Zoom-Zoom to Show All

Button:

Key: Home key
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Zooming on the Reference Frame
You can zoom on the Reference Frame.

To Zoom on the Reference Frame:
� On the View menu, click Zoom-Zoom On Frame.

ProbeMaster zooms on the Reference Frame.

Menu: View-Zoom-Zoom on Frame

Button: None

Key: W

Automatic Zoom-on-Frame Feature
You can set ProbeMaster to automatically zoom on the Reference Frame whenever a new Frame is
drawn. Or you can turn the feature off so that ProbeMaster does not automatically zoom on a new
Reference Frame.

To Select to Automatically Zoom when a New Frame is Drawn:
1. On the View menu, go to Zoom and look at Zoom On.

• If Zoom On has a checkmark next to it, then ProbeMaster will automatically zoom on
the Reference Frame whenever a new Frame is drawn.

• If Zoom On has no checkmark next to it, then ProbeMaster will not automatically
zoom on a new Reference Frame.

2. Click Zoom On to switch between automatically zooming on a new Frame and not
automatically zooming on a new Frame.

Menu: View-Zoom-Zoom On

Button: None

Key: None
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Zooming to a Specific Zoom Level
You can set an exact zoom level.

To Zoom to a Specific Zoom Level:
1. On the View menu, click Zoom-Set Zoom Level.

ProbeMaster prompts for a zoom level.

Set Zoom Level

2. On the Set Zoom Level dialog, enter the zoom level and click OK .

ProbeMaster zooms to the zoom level you selected.

Menu: View-Zoom-Set Zoom Level

Button:    Type the zoom level into the control and then move the mouse into the
viewing area.

Key: Z
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Going to Specific Locations on Screen
ProbeMaster has many commands for going to specific location or specific types of data on screen.

Moving the Cursor Manually
You can manually move the cursor around on the viewing area using the mouse or the arrow keys.

Using the Mouse
Moving the mouse moves the cursor around the screen. You can use the mouse to move the cursor
outside the viewing area to click on menus and buttons, which is something you cannot do using the
arrow keys. When the screen grid is turned on, moving the cursor with the mouse allows you to
position the cursor off of the grid points, which is also something you cannot do using the arrow keys.

Using the Arrow Keys
Pressing the arrow keys moves the cursor up, down, left or right on the viewing area. When the screen
grid is turned on, pressing the arrow keys causes the cursor to hop from one grid point to the next. The
arrow keys cannot be used to move the cursor outside the viewing area to click on menus and buttons.
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Going to Specific X, Y Coordinates
You can go a specific X, Y coordinate.

To Go to Specific X, Y Coordinates:
1. On the View menu, click Go To-Coordinates.

ProbeMaster prompts for X and Y coordinates.

Move Cursor To dialog

2. On the Move Cursor To dialog, enter new X and Y coordinates and press the Enter key.

ProbeMaster moves the cursor to the X and Y coordinates.

Note: It is usually preferable to close the dialog using the Enter key instead of clicking OK.
Clicking OK can sometimes cause you to jiggle the mouse and move the cursor off of the
coordinates you set.

Menu: View-Go To-Coordinates

Button:  Click the X or Y buttons.

Key: X key or Y key

Selecting a Test Point or Pad
Selecting an element causes the cursor to hop to the nearest element. The D Code, net number and
probe number of the selected element is displayed on the Status Bar.

To Select a Pad or Test Point:
� Position the cursor next to the test point or pad and press the S key.

Menu: None

Button: None

Key: S
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Going to the Last Selected Test Point
Pressing Ctrl+H  moves the cursor to the last selected test point. If the selected test point is off the
screen, ProbeMaster redraws the screen at the current zoom level with the selected test point in the
center. A green cross marks the selected test point.

To Go to the Last Selected Test Point:
� Press Ctrl+H .

Menu: None

Button: None

Key: Ctrl+H

Going to the Next Highlighted Element
Pressing the N key moves the cursor sequentially to the next highlighted element. Use this command to
find every highlighted element in sequence. For the highlighting commands, see Highlighting Data on
Screen on page 22.

To Go to the Next Highlighted Element:
1. Highlight the elements.

2. Press the N key.

Menu: None

Button: None

Key: N
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Going to a Test Point Number
Each test point is assigned a unique test point number when the test files are exported. Most moving
probe testers report faults between test point numbers (i.e., a short between test points 14 and 25). You
can go a specific test point number. ProbeMaster also has a command that allows you to display the
test point number of each pad next to each pad. See Displaying Test Point Numbers on page 20.

To Go to a Test Number:
1. On the View menu, click Go To-Test Number.

ProbeMaster prompts for a test point number.

Go to Test Number Dialog

2. On the Test Number dialog, enter a test point number and click OK .

ProbeMaster moves the cursor to the test point number.

Note: If all the test point numbers appear to be zero, it is because the test files have not been
exported yet. The test point numbers are generated when the data is exported.

Menu: View-Go To-Test Number

Button:

Key: None
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Going to Collision Errors
You can go to each collision error. For more about collision errors, see Checking for Collision Errors
on page 105.

To Go to Collision Errors:
1. On the View menu, click Go To-Collide.

The Go To Collision Error  tool is selected.

2. Click the mouse in the viewing area.

The cursor hops to the next sequential collision error. The Go To Collision Error  tool remains
selected until you select another tool or press the Escape key, so you can go to one collision error
after another by clicking the mouse.

Menu: View-Go To-Collide

Button:

Key: None

Going to Possibly Probeable Pads not Given Test Points
You can go to each instance of pads possibly covered by soldermask or silkscreen. For more about
pads that may be covered by silkscreen or soldermask, see Possibly Probeable, Possibly Covered Test
Points on page 80.

To Go to Possibly Probeable Pads not Given Test Points:
1. On the View menu, click Go To-Probeable TP.

The Go To Possibly Probeable Pads tool is selected.

2. Click the mouse in the viewing area.

The cursor hops to the next sequential possibly probeable pad not given a test point. The Go To
Possibly Probeable Pads tool remains selected until you select another tool or press the Escape
key, so you can go to one possibly probeable pad after another by clicking the mouse.

Menu: View-Go To-Probeable TP

Button:

Key: None
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Using the Screen Grid
The program has a screen grid that can be used for precisely positioning the cursor. The grid can be
turned on and off as needed.

When the grid is on:

• The cursor moves only on the grid points when moved with the arrow keys.

• The cursor snaps to the closest grid point when you activate an editing command such as
insert, copy or move.

• The cursor can be moved off the grid using the mouse or by aligning to an element.

Some settings affect the behavior of the grid:

• The grid unit  determines the spacing of grid points.

• The space between grid points can be fixed at one interval or can be set to be variable
depending on the zoom level.

• The grid can be anchored so that it does not move, or it can be dragged by the cursor.

Turning the Screen Grid On or Off
You can turn the display of the screen grid on and off.

To Turn the Screen Grid On or Off:
1. On the View menu, go to Screen Grid and look at Display Grid.

• If Display Grid has a checkmark, the grid is On.

• If Display Grid has no checkmark, the grid is Off .

2. Click Display Grid  to turn the grid on or off.

Menu: View-Screen Grid-Display Grid

Button:   Up = Off, Down = On

Key: G
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Anchored or Dragged Grid
The grid can be Anchored in place so that it does not move. When the grid is set to Anchored mode
and the cursor is moved, the cursor hops from one grid point to the next.

Or the grid can be Dragged so that it is moveable. When the grid is set to Dragged mode and the
cursor is moved, the cursor drags the grid to a new position.

Generally the grid is left in Anchored mode and is only put in Dragged mode when it needs to be
repositioned.

To Switch between an Anchored Grid and One that can be Dragged:
1. On the View menu, go to Screen Grid and look at Anchored and Dragged. The position of

the bullet indicates the status of the grid:

• If there is a bullet on Anchored, the grid is stationary, and the cursor hops from one grid
point to the next.

• If there is a bullet on Dragged, the grid is moveable, and the cursor drags the grid.

2. To switch between the two states, click Anchored or Dragged.

Menu: View-Screen Grid-Anchored or Dragged

Button:   Up = Dragged, Down = Anchored

Key: Shift+G
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Fixed or Variable Grid
The grid can be set to Variable or Fixed mode. The difference between these two modes is the interval
displayed between grid dots.

• Variable Mode: The program changes the displayed grid interval so that a comfortable
number of grid dots appears on screen at any zoom level. The displayed grid interval will be
equal to a multiple of the grid unit. The possible grid intervals are grid unit times a power of
ten or any such value divided by two.

As you increase the zoom level, the grid interval becomes smaller to the point of the finest
resolution until it reaches the grid unit. It will never be smaller than the grid unit.

• Fixed Grid:  The interval displayed between grid dots is always equal to the grid unit, at any
zoom level. The grid interval does not change until the screen is almost filled with grid dots.
When there are too many dots to display, the grid becomes invisible, but it is still on.

To Switch between a Fixed Interval Grid and One that is Variable with Zoom:
1. On the View menu, go to Screen Grid and look at Variable and Fixed. The position of the

bullet indicates the status of the grid:

• If there is a bullet on Variable, the grid interval is variable depending on zoom level.

• If there is a bullet on Fixed, the grid interval is fixed regardless of zoom level.

2. To switch between the two states, click Variable or Fixed.

Menu: View-Screen Grid-Variable or Fixed.

Button:   Up = Fixed, Down = Variable

Key: Ctrl+G
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Grid Units
The grid unit is the basis of the grid interval, the space between grid points.

To Set the Grid Unit:
1. On the View menu, click Screen Grid-Units.

ProbeMaster prompts you to set the grid unit.

Grid Unit Dialog

2. On the Grid Unit  dialog, enter the new grid unit and click OK .

ProbeMaster displays the grid based on the new grid unit.

Menu: View-Screen Grid-Units.

Button:

Key: None
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Displaying Statistical Information
ProbeMaster has two commands for displaying statistical information. One shows data strictly related
to the imported PCB data: the pad and trace counts for each net in the currently loaded PCB data. And
the other shows job statistics related to the processing of the job: the size of the PCB; the counts of
surface mounts, through holes and traces; the number of errors, number of probeable and unprobeable
nets; net adjacency information; and other information.

Showing the Pad and Trace Counts for each Net
ProbeMaster can display a dialog that shows the pad and trace counts for each net in the currently
loaded PCB data.

Note: This information can be useful for finding the power and ground plane nets that are required
for the setting up the Plane Nets table. See Identifying Power and Ground Plane Nets on
page 63.

To Show the Pad and Trace Counts for each Net:
� On the View menu, click Data Elements-Net/Pad/Trace Counts.

Pad and Trace Counts per Net

Menu: View-Data Elements-Net/Pad/Trace Counts

Button: None

Key: None
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Showing the Job Statistics
ProbeMaster can display a dialog that shows statistics for the current job.

To Show the Job Statistics:
� On the View menu, click Statistics.

Test Information Statistics Dialog

Menu: View-Statistics

Button: None

Key: F6
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Measuring Distance
ProbeMaster allows you to measure distance in the viewing area in two different ways. You can
measure the straight-line distance between two points in Distance Measurement mode. Or you can
use a Relative Origin, which gives you the X and Y distances from one point to the other.

Using Distance Measurement Mode
When Distance Measurement mode is on, the Status Bar shows distance between the current cursor
position and the point on screen where the cursor was when Distance Measurement mode was turned
on.

To Measure Distance with Distance Measure Mode:
1. Position the cursor at the point on screen where you want to measure distance from.

2. Press the D key.

ProbeMaster marks the starting point on screen with a yellow X and goes into Distance Measure
mode. The Status Bar begins displaying the distance between the starting point on screen and the
cursor position.

Distance Displayed in Status Bar

3. Move the cursor to the point on screen where you want to measure distance to.

The Status Bar displays the distance between the starting point on screen and the cursor position.
ProbeMaster remains in Distance Measurement mode until you press D again.

Menu: None

Button: None

Key: D
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Using the Relative Origin
Ordinarily the Screen toolbar shows the cursor’s X and Y coordinate position relative to the absolute
origin, X=0, Y=0. When the Relative Origin is turned on, the Screen toolbar shows cursor’s dx and
dy position relative to the Relative Origin, dx=0, dy=0. The Relative Origin, dx=0, dy=0, is the point
on screen where the cursor was when the Relative Origin was turned on.

To Measure Distance with the Relative Origin:
1. Position the cursor at the point on screen where you want to measure distance from.

2. Press the R key.

ProbeMaster switches to Relative Origin mode. Instead of the normal X, Y coordinates, the
Screen toolbar begins displaying the cursor position as the dx and dy coordinates relative to the
position on screen where Relative Origin mode was turned on.

Absolute Origin Mode

Relative Origin Mode

3. Move the cursor to the point on screen where you want to measure distance to.

The Screen toolbar displays the dx and dy distance between the Relative Origin and the cursor
position. ProbeMaster remains in Relative Origin mode until you press R again.

Menu: None

Button: None

Key: R
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Metric or English Units
ProbeMaster can convert units of measurement for the current job between English and metric units.

To Select Metric or English Units:

1. On the Screen toolbar, click the Coordinate Units drop down  and select either
Inches or mm.

ProbeMaster prompts, “Convert all data and parameters to metric/English?”

2. Click Yes.

ProbeMaster converts the database to the new units.

Menu: None

Button:

Key: None
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Using the Reference Frame
ProbeMaster features a Reference Frame, which is used by many commands to select elements for an
operation. You can automatically insert a Reference Frame around all data, or you can draw a new
frame at a new location or a new size using a mouse-operated Frame-drawing tool. You can also set
ProbeMaster to automatically zoom on the Reference Frame whenever a new Frame is drawn. Or you
can turn the feature off so that ProbeMaster does not automatically zoom on a new Reference Frame.
For more information on the automatic Zoom-on-Frame feature, see Automatic Zoom-on-Frame
Feature on page 30.

Inserting a Reference Frame around All Data
You can automatically insert a Reference Frame around all data.

To Insert a Reference Frame around All Data:
� Press Ctrl+W.

ProbeMaster inserts a Reference Frame around all data.

Menu: None

Button: None

Key: Ctrl+W

Drawing a New Reference Frame
You can draw a new frame at a new location or a new size using a mouse-operated Frame-drawing
tool.

To Draw a New Reference Frame:

1. On the Screen toolbar, click the New Window  button.

The New Window button stays down and the Frame-drawing tool is selected.

2. Position the cursor where you want one corner of the Frame to be to be. Then click the mouse
and drag the cursor to where you want the opposite corner.

The Frame-drawing tool remains selected until you select another tool or press the Escape key.

Menu: None

Button:

Key: Shift+W
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Chapter 5
Setting up the Tester Configuration

Before processing the job, set up the tester configuration.

Using Boilerplate Jobs
All tester configuration and operation settings can be saved in a .JOB file. If you typically have similar
jobs, you can open a previously saved boilerplate .JOB file, import the new PCB data, and begin
processing without having to reset all of the settings.

Selecting the Tester Type
The tester you will be using affects the operation of several ProbeMaster functions, such as tagging
fiducials. It also affects the format of tester download files. So before anything else, you should select
the type of tester you will be using.

To Select the Tester Type:
1. On the Setup menu, click Tester.

Tester Dialog
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2. On the Tester dialog, select the tester you are using from the Tester drop down list.

The other settings on the Tester dialog are not specifically related to setting up the tester, although
what is displayed in those settings does depend on the tester selected.

• Identify Plane Nets for Phase: In this table you identify the plane nets in the given job,
and that information is used when doing capacitance testing (phase difference or
impedance). How this table is displayed depends on the tester selected; however the
information is entered on a job-by-job basis and is not part of the tester setup. For
information on setting up this table, see Identifying Power and Ground Plane Nets on
page 63.

• Minimum Net Separation: ProbeMaster uses this entry when generating the adjacency
data. For information on generating adjacency data and setting up this field, see Net
Adjacency on page 123.

3. Click OK .

Menu: Setup-Tester

Button: None

Key: None
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Setting up the Probes
Using the Probe Setup dialog, you define the parameters for the probes that will be used to test pads
on the currently active side of the board.

Head diameters, air gaps, and stagger margins are used when running collision checks and staggering
test points.

Note: The issues involved when setting these parameters in ProbeMaster are simpler than in
FixMaster where many types of probes may be used. Generally, moving probe testers will
only have one kind of probe in use at a time; however, you may still need to define the
parameters a little differently for probing different types of pads. For instance, you may want
different stagger margins for different types of pads. In that case, you can set up two Probe
Codes for identical probes with different stagger margins and map them to different D Codes.
This is the reason for more than one probe in the probe table.

To Set up the Probes:
1. On the View Menu, click Active Side, and select the Active Board Side for which you want

to set up probes.

There are two Probe Setup tables, one for component-side testing and one for solder-side testing.
If you are setting up probes for both sides, set up one set for the currently active side, then come
back and set up the other side. Generally the two sides are set up with the same probe parameters.

2. On the Setup menu, click Probe Table.

Probe Setup Table
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3. In the Type column of the Probe Setup dialog, set the Probe Types.

You need to tell ProbeMaster what type of pads can be probed with each Probe Code. If you want
to set up the parameters a little differently for through holes than for surface mounts, this setting
tells ProbeMaster which Probe Code is appropriate for each use. In the Probe Setup dialog, enter
the type of each probe in the Type field. Later, each D Code to be tested will be mapped to a
Probe Code, meaning that a probe having that Probe Code will be used to test pads of that D Code.
For information on mapping D Codes to Probes, see Mapping D Codes to Probe Codes on page
65.

• For probes for through-hole drills, enter H.

• For probes for surface-mount pads (SMD), enter S.

• For probes for both through-hole drills and surface-mount pads, enter B.

• Type T is for Tooling Holes, and it is not generally used in ProbeMaster, only in
FixMaster. A type T probe isn't actually a probe. Type T probes are used in FixMaster to
indicate the diameter of tooling holes in the drill output files.

4. In the Head Dia column, enter the head diameter of each probe.

The Head Diameter of the probe is used for collision checking. For information on collision errors,
see Checking for Collision Errors on page 105.

5. In the Air Gap  column, enter an air gap for each probe.

The Head Diameter of each probe is swelled by its Air Gap when checking for collisions. For
information on collision errors, see Checking for Collision Errors on page 105.

6. In the Margin  column, enter a stagger margin for each probe.

The Margin is used when staggering test points. For surface-mount pads, the margin is how much
to set back the test point from the pad edge. For through-hole pads, the margin is either the amount
to stagger the test point inward from the hole edge or the amount to stagger the test point outward
from the hole center point. You can also enter a negative margin and stagger the test point outward
from the hole edge to probe the covering pad. The option to measure from the edge or from the
center point is set on Setup-Test Point-Stagger, along with the option to stagger the test point
toward the top, bottom, right or left of the pad. For more information about staggering test points,
see Staggering Test Points on page 93.

Note: Setting up different stagger margins for different types of pads is one of the main reasons
for setting up different types of probes in ProbeMaster.

7. Click OK .

Menu: Setup-Probe Table

Button: None

Key: None
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Chapter 6
Positioning the PCB

After you import the PCB data, you must position the PCB data within the test area. ProbeMaster has
several commands for mirroring, moving, rotating and stepping and repeating the PCB data.

Mirroring the PCB
The Mirror  command flips PCB data for the current board side in either the X or Y directions.

Note: Be sure that you leave the data oriented properly when you use the Mirror  command. The
data need to be oriented in the same way that the board will be loaded into the tester.

To Mirror the PCB:
1. Set the current Board Side.

2. Position the Frame around the data you want to mirror.

3. On the Edit  menu, click PCB Data-Mirror .

4. Select the direction to flip the data.

None: The data is not flipped.

Flip X:  The data is flipped horizontally, along the X axis, so that left becomes right.

Flip Y:  The data is flipped, vertically, along the Y axis, so that up becomes down.

5. Click OK .

Menu: Edit-PCB Data-Mirror

Button:  then  or 

Key: None
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Moving the PCB
The Move command moves PCB data for both board sides.

To Move the PCB:
1. Position the Frame around the data you want to move.

2. On the Edit  menu, click PCB Data-Move.

ProbeMaster prompts for a reference location.

3. Position the cursor at the reference location.

4. Click  the mouse or press Enter.

ProbeMaster marks the reference position with a yellow crosshair and prompts for a destination
position.

5. Position the cursor at the destination location.

6. Click  the mouse or press Enter.

ProbeMaster moves the data in the Frame as a group so that the reference location moves to the
destination location.

Menu: Edit-PCB Data-Move

Button:  then 

Key: None
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Rotating the PCB
The Rotate command rotates PCB data for both board sides.

Direction
Rotation is clockwise in multiples of 90 degrees.

D Codes
ProbeMaster transcodes the asymmetrical pads to existing D Codes of the correct size or to new
D Codes defined to match the rotated pads.

To Rotate the PCB:
1. Position the Frame around the PCB data you want to rotate.

2. Go to the Edit  menu and click PCB Data-Rotate.

3. If you want to rotate the PCB data around a specific cursor location:

• Position the cursor at the center of rotation.

• Click  the mouse or press Enter.

• On the Rotate dialog, enter the Angle of rotation.

• Select to Rotate Around Cursor.

• Click OK .

Rotate Around Cursor
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If you want to rotate the PCB data around the center of the selection:

• Click  the mouse or press Enter.

• On the Rotate dialog, enter the Angle of rotation.

• Select to Rotate Around Center of Selection.

• Click OK .

Rotate Around Center

ProbeMaster rotates the data within the Frame around the designated pivot point. ProbeMaster
transcodes the asymmetrical pads to existing D Codes of the correct size or to new D Codes
defined to match the pads.

Menu: Edit-PCB Data-Rotate

Button:  then 

Key: None
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Stepping and Repeating the PCB
The Step/Repeat commands step and repeat PCB data for both board sides. Some types of testers
support coded step and repeat, which makes use of codes in the data file that tell the tester to create and
position copies of the image. Other testers do not support coded step and repeat, and instead you must
use the non-coded step and repeat in which ProbeMaster makes copies of the data and positions each
copy as you specify.

Non-Coded Step and Repeat
In a non-coded step and repeat, the ProbeMaster copies the PCB data and each copy is placed in an
offset location. This method does not make use of step and repeat codes, so it is supported by all
formats of testers. This method makes a larger data file than the coded step and repeat because each
image of the data is a copy of the original.

Direction of Step and Repeat
The original image is the lower left copy in the pattern and the new copies are stepped up to the right
and above the original.

Net Numbers after Step and Repeat
Each net in the original PCB data is assigned a unique new net number in each new copy of the data.

To Perform a Non-Coded Step and Repeat of the PCB:
1. Position the Frame around the data you want to step and repeat.

2. On the Edit  menu, click PCB Data-Step/Repeat-Non Coded.

Step and Repeat Dialog
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3. On the Step and Repeat dialog, enter the following:

• Copies X, Y: Enter the number of copies you want in the X and Y directions.

• Step X, Y: Enter the distance to step the image in the X and Y directions. This is the
distance from the lower left corner of one image to the lower left corner of the next
image.

4. Click OK .

ProbeMaster makes multiple copies of the data in the Frame and positions them to the right and
above the original by the distances you specified. Each net in the original PCB data is assigned a
unique new net number in each new copy of the data.

Menu: Edit-PCB Data-Step/Repeat-Non Coded

Button:  then 

Key: None
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Coded Step and Repeat
In coded step and repeat ProbeMaster adds codes to the data file that tell the tester to create and
position copies of the image. ProbeMaster does not display the entire stepped and repeated array, only
the original image. This method makes a smaller data file than the non-coded step and repeat because
instead of creating a full copy of all the original data for each image in the step and repeat pattern,
ProbeMaster inserts an instruction code telling the tester to generate the images. Because different
testers use different types of step and repeat codes, not all tester types have a supported coded step and
repeat function in ProbeMaster. Also, depending on the tester, there are different dialogs for setting up
the coded step and repeat. If your tester does not have a supported coded step and repeat function in
ProbeMaster, then you will have to do a non-coded step and repeat. See Non-Coded Step and Repeat
on page 55.

MP-440 Format 1 Coded Step and Repeat
Format 1 coded step and repeat for the MP-440 tester is a simple, non-nested coded step and repeat.
You set it up the same way you would set up the normal non-coded step and repeat.

To Perform a Format 1 Coded Step and Repeat for MP-440:
1. On the Edit  menu, click PCB Data-Step/Repeat-Coded-Format 1.

Coded Step and Repeat for MP440 Format 1

2. On the Step and Repeat dialog, enter the following:

• Copies X, Y: Enter the number of copies you want in the X and Y directions.

• Step X, Y: Enter the distance to step the image in the X and Y directions. This is the
distance from the lower left corner of one image to the lower left corner of the next
image.

3. Click OK .

ProbeMaster generates the step and repeat codes that will tell the tester how to generate and
position the stepped and repeated images.

Menu: Edit-PCB Data-Step/Repeat-Coded-Format 1

Button: None

Key: None
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MP-440 Format 2 Coded Step and Repeat
Format 2 coded step and repeat for the MP-440 tester is no longer used by MicroCraft.

Coded Step and Repeat for MP440 Format 2
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MP-440 Format 3 Coded Step and Repeat
Format 3 coded step and repeat for the MP-440 tester is exported using the same data format as the
IPC format described in MP-440 Format 4 Coded Step and Repeat on page 61; however format 3 has a
setup dialog that is easier to set up than format 4. The format 3 setup dialog uses a nested step and
repeat technique in which each new line in the dialog applies to the whole image generated in the
previous line.

To Perform a Format 3 Coded Step and Repeat for MP-440:
1. On the Edit  menu, click PCB Data-Step/Repeat-Coded-Format 3.

Coded Step and Repeat for MP440 Format 3

The format 3 setup dialog uses a nested step and repeat technique in which each new line in the
dialog applies to the whole image generated in the previous line.

2. In the first line enter the following:

• Step X or Step Y: This is the distance from the lower left corner of one image to the
lower left corner of the next image. Enter the distance to step the image in either the X or
the Y directions. Don’t enter a value for both X and Y. Instead step the image in one
direction in one line of the table, and then step the resulting image in the other direction
in the next line.

• Copies: Enter the number of copies you want stepped for this line.

• Mirror X Mirror Y:  If you want the images mirrored, enter a checkmark.
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3. If you now want to step the image created by the first line, enter the Step X/Y, Copies and
Mirror X/Y  values in line 2, and so on. For instance, if you wanted a 4 by 6 array, you could
enter 4 copies in line 1 and 6 copies in line 2.

4. When you have entered all the lines you need in the table, click OK .

ProbeMaster generates the step and repeat codes that will tell the tester how to generate and
position the stepped and repeated images.

Menu: Edit-PCB Data-Step/Repeat-Coded-Format 3

Button: None

Key: None
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MP-440 Format 4 Coded Step and Repeat
Format 4 coded step and repeat for the MP-440 tester is a IPC specified format. Each line in the format
4 setup table specifies the position and orientation of one image of the original. For instance, a six-up
image is formed by the original image and five entries in the table. This format allows the greatest
control because each image is individually positioned, but it can take a long time to set up the table if
there are very many images in the step and repeat pattern. The format 3 coded step and repeat
described in MP-440 Format 3 Coded Step and Repeat on page 59 is exported using the same IPC
format used in format 4, but the format 3 dialog is easier to set up.

To Perform a Format 4 Coded Step and Repeat for MP-440:
1. On the Edit  menu, click PCB Data-Step/Repeat-Coded-Format 4.

Coded Step and Repeat for MP440 Format 4

2. In the first line enter the following values to specify the position and location of the first copy
of the image:

• Step X and Step Y: Enter the position of the lower left corner of the image relative to the
origin.

• Rotate: Enter the number of degrees, if any, to rotate this copy of the image.

• Mirror Y:  If you want the images mirrored, enter a checkmark.

3. In the second line enter the Step X/Y, Rotate and Mirror Y  values to specify the position
and location of the next copy of the image and so on until all the images have been specified.

4. If there are not enough lines in the table to specify all the images, press the Insert key to
insert more lines.
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5. When you have entered all the lines you need in the table, click OK .

ProbeMaster generates the step and repeat codes that will tell the tester how to generate and
position the stepped and repeated images.

Menu: Edit-PCB Data-Step/Repeat-Coded-Format 4

Button: None

Key: None

AFT Coded Step and Repeat

Coded Step and Repeat for AFT
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Chapter 7
Identifying Power and Ground Plane Nets

Testers that do capacitance testing (phase difference or impedance) need power and ground plane nets
to be identified in the tester download files. Each net to be tested needs to be identified with a
corresponding plane net that is above the net to be tested or below it in the PCB design. Because the
net to be tested and the plane net are above or below each other and separated by a layer of substrate,
their capacitance can be tested using an impedance or phase difference method. And if the capacitance
is within certain tolerances, the net being tested is considered to be continuous and isolated. This
method is a lot faster than testing every point of a net.

Lavenir Format 2 and Format 4 netlists (.F02 and .F04) that are extracted by the Lavenir CAMMaster
and ViewMaster PRO netlist extraction routines contain data that identify the power and ground nets,
and ProbeMaster uses this data to fill in the plane net table automatically. If you want to verify, add to,
or delete from the list of power and ground nets, or if you need to identify power and ground nets for
netlists that were not extracted using the Lavenir netlist extraction routines, ProbeMaster allows you to
edit the plane net table manually.

Note: If you need to set up the power and ground planes manually, knowing the pad and trace
counts for each net can help you determine which nets are planes. See Showing the Pad and
Trace Counts for each Net on page 41.

To Identify Power and Ground Nets Manually:
1. On the Setup menu, click Tester.

2. On the Tester dialog, go to the Identify Plane Nets for Phase table. The numbers on the far
left of the table refer to the net numbers of nets to be tested, and the column to the right of that
contains the net numbers for the power and ground plane nets that correspond to each net to
be tested. The Identify Plane Nets for Phase table changes depending on the type of tester
selected in the Tester drop down list, and for some testers there is an additional column for
the layer of the plane net. Images of the Identify Plane Nets for Phase table for each type of
tester follow.

3. For each net number on the left enter a corresponding plane net (or nets, separated by
commas) in the Plane Nets column. If called for, you may also enter the layer of the plane net.

4. If there are not enough net numbers in the table, press the Insert key to add more nets to the
table.
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Plane Nets Table for the MP440

The Plane Nets Table for Probot, Hummingbird, AFT and Probotech
are all the same and have a Layer Number column

Menu: Setup-Tester

Button: None

Key: None
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Chapter 8
Mapping D Codes to Probe Codes

Note: The issues involved when mapping D Codes to Probes in ProbeMaster are simpler than in
FixMaster where many types of probes may be used. Generally, moving probe testers will
only have one kind of probe in use at a time; however, you may still need to use different
Probe Codes for probing different types of pads. For instance, you may want different stagger
margins for different types of pads. In that case, you can set up two Probe Codes for identical
probes with different stagger margins and map them to different D Codes. Also, the procedure
allows you to exclude certain D Codes, such as non-plated through holes from test.

After the PCB data has been imported, you tell ProbeMaster how to handle each D Code by mapping
D Codes to Probe Codes. Each D Code can be set to represent one of the following types of pad:

• A pad that is going to be probed.

• A pad that is not going to be probed.

Note: There is also a setting to designate a D Code as a PCB tooling hole, but it is not generally
used in ProbeMaster, only in FixMaster. Tooling hole D Codes are used in FixMaster to
indicate D Codes in the PCB that are to be transferred to the fixture and included in the drill
output files.

After each pad is given a type:

• Each pad that is to be probed must be mapped to a specific Probe Code. The Probe Code
identifies the probe used to test that pad.

• Pads that are not going to be probed do not need any further processing.
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D Code to Probe Mapping Table
The D Code to Probe Mapping Table is where you map D Codes in the imported PCB data to Probe
Codes that you have set up in the Probe Table.

D Code to Probe Map Table

The D Code to Probe Mapping table contains the following information.

D Code
The D Code column contains all the D Codes found in the imported PCB data.

Count
The Count column shows how many pads of each D Code are in the imported PCB data.

X/Y Size
The X and Y Sizes show the dimensions of the each D Code in the imported PCB data.

Shape
The Shape column shows the shape of the each D Code in the imported PCB data. The letters that
identify each shape are consistent with those used in the Lavenir CAM software (CAMMaster,
ViewMaster PRO, and ViewMaster). Elements that were obrounds or rounded rectangles in the
original file are imported as circles, squares or rectangles and are shown as surface mounts.
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Type
The Type column identifies how the particular D Code is to be handled in ProbeMaster. The procedure
that follows describes how to enter these values. You may already know how each D Code is to be
handled, or you may be able to determine this from the Size and Shape values.

Probe
The Probe column identifies the Probe Code that is mapped to the corresponding D Code. Probe Code
values are set up in the Probe Table. For information on the Probe Table, see Setting up the Probes
on page 49. Here you select a Probe for each pad that is appropriate to the D Code Type, Shape and
Size. The procedure that follows shows how you can manually map the D Codes to Probe Codes.
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Manually Mapping D Codes to Probe Codes
You can manually map D Codes to Probes.

To Manually Map D Codes to Probe Codes:
1. Set the current board side.

2. You may have already set up the Probe Code parameters in the tester configuration
procedures by going to the Setup menu, and clicking Probe Table. This step is not required
for mapping the D Codes to Probe Codes, but it may help guide your choices for Probe Codes
later in the procedure and will be necessary for generating test points. See Setting up the
Probes on page 49.

3. On the Action menu, click D Code to Probe.

D Code to Probe Map Table
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4. For each D Code, enter a Type.

Type-0 D Code: Unprobed pad. No test points will be generated for type-0 pads.

Type-1 D Code: Probed pad. Test points will be generated for type-1 pads.

Type-2 D Code: Tooling hole, not probed. No test points will be generated for type-2 pads. Type-
2 pads are not generally used in ProbeMaster, only in FixMaster. Tooling hole D Codes are used
in FixMaster to indicate D Codes in the PCB that are to be transferred to the fixture and included
in the drill output files.

5. For each type-1 D Code, enter a Probe Code.

Type-0 D Code: Don’t map a Probe Code for type-0 pads. These are unprobed pads.

Type-1 D Codes: Map each type-1 D Code to an appropriate Probe Code from the Probe Setup
table. A probe having that Probe Code will be used to test pads of that D Code.

• For surface-mount pads, use a type-S or type-B Probe Code.

• For through-hole pads, use a type-H or type-B Probe Code.

Type-2 D Codes: Type-2 pads are not generally used in ProbeMaster, only in FixMaster. Tooling
hole D Codes are used in FixMaster to indicate D Codes in the PCB that are to be transferred to
the fixture and included in the drill output files.

6. When all D Codes are mapped to Types and Probe Codes, click OK .

7. If you have mapped D Codes to Probe Codes for one board side and need to map them for the
other side, you can go back and do it now.

Menu: Action-D Code to Probe

Button:

Key: F5
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Chapter 9
Adding Test Points

A test point is a location in the PCB data that is to be probed during the test. In ProbeMaster a test
point is defined by its X and Y location, the component it is in, and the Probe Code it is mapped to.
This chapter describes how to automatically generate test points and to edit test points in ProbeMaster.

Generating Test Points
ProbeMaster can generate test points for all pads mapped as probeable (Type-1 D Codes) in the
D Code to Probe map, or for only selected probeable pads limited by the options you set.

To Generate Test Points for Netlist Data:
1. Set the Current Board Side.

2. To determine which pads are probeable and what types of probes can be used for each pad,
map D Codes to Probe Codes. See Mapping D Codes to Probe Codes on page 65.

3. Go to the Setup menu and click Test Point-Generate.

Set Up Test Point Generation
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4. On the Generate Config dialog, set up the additional options for generating test points for
netlists. These options are described in detail in the sections that follow this procedure.

Options Group Box: You may select any of these options when generating test points for netlist
data of any format. Not all options are compatible with other options.

• Test Single pt Nets: See Test Points for Single-Point Nets on page 73.

• Use Gerber Soldermask: See No Test Points Covered by Gerber Soldermask on page
77.

• Use Gerber Silkscreen: See No Test Points Covered by Gerber Silkscreen on page 77.

• Balanced Through-Holes: See Equal Number of Through-Hole Test Points Per Board
Side on page 74.

• One Test Point Per Net: See One Test Point Per Net on page 74.

• Component Side Through-Hole Only: See All Through-Hole Test Points on One Board
Side on page 75.

• Barrel Optimize:  See Through-Hole Test Points on Opposite Board Side from Incoming
Trace on page 76

IPC Options Group Box: You may select any of these options when generating test points for
IPC format netlists with the appropriate records (including Lavenir formats .F02 and .F04). Not all
options are compatible with other options.

• SMD: Test Endpoints Only: See Surface-Mount Pads: Test Points for Endpoints Only
on page 78.

• Through-Holes: Test Endpoints Only: See Through-Hole Pads: Test Points for
Endpoints Only on page 79.

• Test Vias: See Test Points for Vias on page 79.

• Vias: Test Endpoints Only: See Vias: Test Points for Endpoints Only on page 79.

• Use IPC Soldermask: See No Test Points for Pads with IPC Soldermask Flags on page
79.

When you have set the options you want, click OK .

5. On the Edit  menu, click Test Point-Insert-All Test Points.

ProbeMaster generates the test points for the current board side as you specified.

Test points are represented by blue crosshairs.

ProbeMaster highlights pads for which test points have been generated.

6. If you need to generate test points for the opposite board side, repeat the procedure.

Menu: Setup-Test Point-Generate

Button: None

Key: None
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Setting up Test Point Generation Options

Set Up Test Point Generation

You may select any of the following options when generating test points for netlist data of any format.

Test Points for Single-Point Nets
ProbeMaster can either generate test points for single-point nets or ignore single-point nets when
generating test points.

ProbeMaster looks at the net designation in the netlist data to determine if a net is a single-point net,
and does not actually count the number of nodes in each net. Nets that have a net number of zero or are
designated with an N/C are considered to be pads with no connections. If your netlist format does not
designate non-connected pads this way, the option will not work.

• To generate test points for single-point nets, click the Test Single Pt Nets option so that it
has a checkmark.

• To ignore single-point nets when generating test points for netlists, click this option so that it
has no checkmark.
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One Test Point Per Net
If you are only testing for shorts between nets, and not testing for continuity, then you need only one
test point per net.

• To generate a test point for only one node of each net, click the One Test Point Per Net
option so that it has a checkmark.

• To generate test points for more than one node per net, click this option so that it has no
checkmark.

Note: This option cannot be selected if any of the through-hole options are selected.

Equal Number of Through-Hole Test Points Per Board Side
ProbeMaster can balance the number of test points generated for through holes on each side of the
board.

• To generate an equal number of test points for through holes on each side of the board, click
on the Balanced Through Holes option so that it has a checkmark.

• If you want to use one of the other through-hole options or if you want through-hole test
points to be generated for the current side each time you generate, click on the Balanced
Through Holes option so that it has no checkmark.

Note: This is one of the three options for generating test points for through holes when both sides of
the board are going to be tested. Only one of these through-hole options can be selected at a
time, and they cannot be used if the One Test Point Per Net option is selected. If none of these
options are selected, then through-hole test points will be generated for the current board
side. This means that you will have test points for both sides of each through hole if you
generate test points for both sides of the board.
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All Through-Hole Test Points on One Board Side
ProbeMaster has an option that can be used to force through-hole test points to one side of the board.
Generally if you are using this option, you want the through-hole test points on the component side, so
this option is called Component Side Through-Holes Only. This option generates test points for
through-holes on the current side only for through-holes that do not already have test points on the
other side.

• If you want to use this option, click on the Component Side Through-Holes Only option so
that it has a checkmark, and generate test points for the side that you want to have the
through-hole test points. ProbeMaster puts test points everywhere that it can, including all
probeable through-holes on the current side. Then when you generate test points for the other
board side, ProbeMaster will not put a test point on the through-holes that received test points
on the first board side.

• If you want to use one of the other through-hole options or if you want through-hole test
points to be generated for the current side each time you generate, click on the Component
Side Through-Holes Only option so that it has no checkmark.

Note: This is one of the three options for generating test points for through holes when both sides of
the board are going to be tested. Only one of these through-hole options can be selected at a
time, and they cannot be used if the One Test Point Per Net option is selected. If none of these
options are selected, then through-hole test points will be generated for the current board
side. This means that you will have test points for both sides of each through hole if you
generate test points for both sides of the board.
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Through-Hole Test Points on Opposite Board Side from Incoming Trace
ProbeMaster can place test points generated for through-holes on the opposite side of the board from
an incoming trace. This allows the integrity of the through-hole to be tested.

Note: This option is for dual-sided testers.

• To generate through holes on the opposite side of the board from the incoming trace, click the
Barrel Optimize option so that it has a checkmark.

If you have turned on both the Barrel Optimize option and the Test Single Point Nets option,
then when you generate test points, ProbeMaster will prompt for extra information regarding
where to test single-point nets that are also through holes. A single-point through hole has no
incoming trace, so you need to tell ProbeMaster where to place the test point. To place all test
points for through-hole pads that are single-point nets on one side of the board, select either CMP
for the component side or SOL for the solder side. To divide the number of test points for these
pads equally between the two sides, select BAL  for balance.

• If you want to use one of the other through-hole options or if you want through-hole test
points to be generated for the current side each time you generate, click on the Barrel
Optimize option so that it has no checkmark.

Note: This is one of the three options for generating test points for through holes when both sides of
the board are going to be tested. Only one of these through-hole options can be selected at a
time, and they cannot be used if the One Test Point Per Net option is selected. If none of these
options are selected, then through-hole test points will be generated for the current board
side. This means that you will have test points for both sides of each through hole if you
generate test points for both sides of the board.
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No Test Points Covered by Gerber Soldermask
To avoid having a probe hit soldermask instead of a pad, you may want to generate test points only for
pads that are completely cleared of soldermask. ProbeMaster can compare PCB data to imported
Gerber soldermask layers (MSU and MSL) to determine if PCB pads are completely cleared of
soldermask. To import Gerber soldermask layers, see Importing Supplemental Gerber Files into the
Job on page 150.

• To generate test points only for pads that are completely cleared of Gerber soldermask, click
the Use Gerber Soldermask option so that it has a checkmark.

When this option is selected, ProbeMaster does not generate test points for pads that are touched at
all by soldermask and marks such pads as possibly probable, possibly covered pads. You can
inspect the possibly covered pads manually and decide whether or not to add test points for these
pads. See Possibly Probeable, Possibly Covered Test Points on page 80.

• To ignore the Gerber soldermask data when generating test points and to generate test points
even for pads that may be touched by soldermask, click the Use Gerber Soldermask option
so that it has no checkmark.

Another option for using soldermask data when generating test points is to use the soldermask flag in
IPC format netlists with soldermask records (including Lavenir formats .F02 and .F04). See No Test
Points for Pads with IPC Soldermask Flags on page 79.

No Test Points Covered by Gerber Silkscreen
To avoid having a probe hit silkscreen instead of a pad, you may want to generate test points only for
pads that are completely cleared of silkscreen. ProbeMaster can compare PCB data to imported Gerber
silkscreen layers (SKU and SKL) to determine if PCB pads are completely cleared of silkscreen. For
information on importing Gerber silkscreen layers, see Importing Supplemental Gerber Files into the
Job on page 150.

• To generate test points only for pads that are completely cleared of Gerber silkscreen, click
the Use Gerber Silkscreen option so that it has a checkmark.

When this option is selected, ProbeMaster does not generate test points for pads that are touched at
all by silkscreen and marks such pads as possibly probable, possibly covered pads. You can
inspect the possibly covered pads manually and decide whether or not to add test points for these
pads. See Possibly Probeable, Possibly Covered Test Points on page 80.

• To ignore the Gerber silkscreen data when generating test points and to generate test points
even for pads that may be touched by silkscreen, click the Use Gerber Silkscreen option so
that it has no checkmark.
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IPC Options Group Box

Set Up Test Point Generation

You may select any of these options when generating test points for IPC format netlists with the
appropriate records (including Lavenir formats .F02 and .F04).

Surface-Mount Pads: Test Points for Endpoints Only
In order to reduce the number of test points, you may want to test only endpoints of a netlist. For IPC
format netlists with midpoint records (including Lavenir formats .F02 and .F04), ProbeMaster allows
you to limit test point generation for surface-mount pads to endpoints only or to generate test points for
all surface-mount pads.

• For surface-mount pads, to generate test points only for netlist endpoints, click the SMD:
Test Endpoints Only option so that it has a checkmark.

• To generate test points for all surface-mount pads, click the SMD: Test Endpoints Only
option so that it has no checkmark.



Chapter 9 Adding Test Points

79

Through-Hole Pads: Test Points for Endpoints Only
In order to reduce the number of test points, you may want to test only endpoints of a netlist. For IPC
format netlists with midpoint records (including Lavenir formats .F02 and .F04), ProbeMaster allows
you to limit test point generation for through-hole pads to endpoints only or to generate test points for
all through-hole pads.

• For through-hole pads, to generate test points only for netlist endpoints, click the Through-
Holes: Test Endpoints Only option so that it has a checkmark.

• To generate test points for all through-hole pads, click the Through-Holes: Test Endpoints
Only option so that it has no checkmark.

Vias: Test Points for Endpoints Only
In order to reduce the number of test points, you may want to test only endpoints of a netlist. For IPC
format netlists with midpoint records (including Lavenir formats .F02 and .F04), ProbeMaster allows
you to limit test point generation for vias to endpoints only or to generate test points for all vias.

• For vias, to generate test points only for netlist endpoints, click the Vias: Test Endpoints
Only option so that it has a checkmark.

• To generate test points for all vias, click the Vias: Test Endpoints Only option so that it has
no checkmark.

Test Points for Vias
In IPC format netlists with via records (including Lavenir formats .F02 and .F04), ProbeMaster allows
you to control test point generation for vias.

• To generate test points for elements that are labeled as vias in the netlist data, click the Test
Vias option so that it has a checkmark.

• If you do not want to generate test points for elements that are labeled as vias in the netlist
data, click the Test Vias option so that it has no checkmark.

No Test Points for Pads with IPC Soldermask Flags
To avoid having a probe hit soldermask instead of a pad, you may want to generate test points only for
pads that are completely cleared of soldermask. ProbeMaster can use the soldermask flag in IPC
format netlists with soldermask records (including Lavenir formats .F02 and .F04) to generate test
points for pads that are not flagged as covered by soldermask.

• To generate test points only for pads that are not flagged in the IPC data as covered by
soldermask, click the Use IPC Soldermask option so that it has a checkmark. When this
option is selected, ProbeMaster does not generate test points for pads that are flagged in the
IPC data as covered by soldermask.

• To ignore the IPC soldermask records when generating test points and to generate test points
even for pads that may be covered by soldermask, click the Use IPC Soldermask option so
that it has no checkmark.

Another option for using soldermask data when generating test points is to use imported Gerber
soldermask layers (MSU and MSL) to determine if PCB pads are completely cleared of soldermask.
See No Test Points Covered by Gerber Soldermask on page 77.
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Possibly Probeable, Possibly Covered Test Points
When you have ProbeMaster generate test points using the options that look at soldermask or
silkscreen data, ProbeMaster will identify pads that are partially covered by silkscreen or are not fully
cleared of soldermask. Because these pads might be covered in such a way that makes them
unprobeable, ProbeMaster does not give them a test point and highlights them in magenta.

ProbeMaster has a command that allows you to find each pad that may be probeable but was not
automatically assigned test points.

After you activate the command and go to the possibly probeable pad, you decide if the pad should
have a test point. Look at the supplemental Gerber soldermask or silkscreen data to see if the pad is
covered. If you determine the pad is probeable, you can insert a test point; otherwise, leave it
unprobed.

For information on importing Gerber soldermask and silkscreen data, see Importing Supplemental
Gerber Files into the Job on page 150.

For information on using the soldermask and silkscreen data when generating test points, see No Test
Points Covered by Gerber Soldermask on page 77, No Test Points Covered by Gerber Silkscreen on
page 77 and No Test Points for Pads with IPC Soldermask Flags on page 79.

To Highlight Possibly Probeable, Possibly Covered Test Points:
� If the magenta highlighting for possibly probeable, possibly covered test points is not being

displayed, go to the Action menu and click Soldermask.

To Go to Each Possibly Probeable, Possibly Covered Test Points:
1. On the View menu, click Go To-Probeable TP.

The Probeable Test Point tool is selected.

2. Click  the mouse.

The cursor hops to the next possibly probeable, possibly covered element. The element is marked
with a green cross, indicating it is selected. Pads that are possibly probeable, but possibly covered
are displayed in magenta.

3. If you determine the pad should be probed, use one of the commands for inserting test points.
See Inserting Test Points on page 81.

The Probeable Test Point tool remains selected until you select another tool or press the Escape
key, so you can find one possibly probeable, possibly covered element after another by clicking
the mouse.

Menu: View-Go To-Probeable TP

Button:

Key: None
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Editing Test Points Manually
The following commands allow you to edit test points in ProbeMaster.

Inserting Test Points
ProbeMaster has several commands for inserting test points manually.

To Insert Test Points Individually:
1. On the Edit  menu, click Test Point-Insert-Insert Single Test Point.

The Insert Test Point tool is selected, and ProbeMaster prompts you to select an element.

2. Position the cursor inside a pad exactly where you want to insert the test point.

Tip: To place the test point at an exact location, you can use the Select Pad command, S, to
put the test point in the center of the pad, or use the mouse or the cursor positioning
commands, X and Y, then press Enter.

3. With the cursor positioned where you want the test point, click the mouse or press Enter.

ProbeMaster inserts a test point at the cursor position.

The Insert Test Point tool remains selected until you select another tool or press the Escape key,
so you can insert one test point after another before quitting the operation.

Menu: Edit-Test Point-Insert-Insert Single Test Point

Button:  then 

Key: Shift+I
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To Insert Test Points in Pads in the Frame:
1. Position the Frame around a group of pads into which you want to insert test points.

2. On the Edit  menu, click Test Point-Insert-Insert Test Point (D Code).

Insert Test Points in all Pads in Frame

3. On the Insert Test Point dialog, select Group and select All .

4. Click OK .

5. After the dialog disappears, click the mouse in the viewing area.

ProbeMaster inserts test points in all the pads within the Frame.

Menu: Edit-Test Point-Insert-Insert Test Point (D Code)

Button: None

Key: None
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To Insert Test Points in Pads of Current D Code in Frame:
1. Position the Frame around a group of pads into which you want to insert test points.

2. On the Edit  menu, click Test Point-Insert-Insert Test Point (D Code).

Insert Test Points in Pads of Current D Code in Frame

3. On the Insert Test Point dialog, select Group and select D Code.

4. Click OK .

The Insert Test Point tool is selected, and ProbeMaster prompts you to select an element.

5. Position the cursor in a pad that has the D Code to which you want to insert test points.

6. Click  the mouse or press Enter.

The cursor hops to the center of the pad, and the D Code of the pad becomes the current D Code
shown in the Status Bar.

7. Click  the mouse or press Enter.

ProbeMaster inserts test points in all the pads within the Frame that have the current D Code.

The Insert Test Point tool remains selected until you select another tool or press the Escape key,
so you can insert test points in pads of one D Code after another before quitting the operation.

Menu: Edit-Test Point-Insert-Insert Test Point (D Code)

Button: None

Key: None



ProbeMaster User’s Guide

84

To Insert Test Points in a Single Net:
1. On the Edit  menu, click Test Point-Insert-Insert Test Point (Net).

Insert Test Points in a Single Net

2. On the Insert Test Point by Net dialog, select Single, and select whether to insert on only the
Current  board side or Both sides.

3. Click OK .

The Insert Test Point tool is selected, and ProbeMaster prompts you to select an element.

4. Position the cursor in a pad of the net to which you want to insert test points.

5. Click  the mouse or press Enter.

The cursor hops to the center of the pad, and the Net Number of the pad becomes the current Net
Number shown in the Status Bar.

6. Click  the mouse or press Enter.

ProbeMaster inserts test points in all pads that have the current Net Number .

The Insert Test Point tool remains selected until you select another tool or press the Escape key,
so you can insert test points in one net after another before quitting the operation.

Menu: Edit-Test Point-Insert-Insert Test Point (Net)

Button: None

Key: None
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To Insert Test Points in a Group of Nets in the Frame:
1. Position the Frame around a group of pads that all belong to the nets into which you want to

insert test points.

Note: The Frame establishes which nets will have test points inserted, not which pads. Every
net that has a pad inside the Frame will have test points inserted in pads that are both
inside and outside the Frame.

2. On the Edit  menu, click Test Point-Insert-Insert Test Point (Net).

Insert Test Points in a Group of Nets in the Frame

3. On the Insert Test Point by Net dialog, select Group, and select whether to insert on only
the Current  board side or Both sides.

4. Click OK .

5. When the dialog disappears, click the mouse or press Enter.

ProbeMaster inserts test points in all pads that have the same Net Number as the pads inside the
Frame.

Menu: Edit-Test Point-Insert-Insert Test Point (Net)

Button: None

Key: None
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Deleting Test Points
ProbeMaster has several commands for deleting test points.

To Delete Test Points Individually:
1. On the Edit  menu, click Test Point-Delete-Delete Single Test Point.

The Delete Test Point tool is selected, and ProbeMaster prompts you to select an element.

2. Position the cursor near a test point you want to delete.

3. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a yellow cross.

4. Click  the mouse or press Enter.

ProbeMaster deletes the marked test point.

The Delete Test Point tool remains selected until you select another tool or press the Escape key,
so you can delete one test point after another before quitting the operation.

Menu: Edit-Test Point-Delete-Delete Single Test Point

Button:  then   then select Single on the dialog.

Key: None
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To Delete Test Points in Frame:
1. Position the Frame around a group of pads from which you want to delete test points.

2. On the Edit  menu, click Test Point-Delete-Delete Test Point (D Code).

Delete Test Points from all Pads in Frame

3. On the Delete Test Point dialog, select Group and select All .

4. Click OK .

5. When the dialog disappears, click the mouse.

ProbeMaster deletes test points from all the pads within the Frame.

Menu: Edit-Test Point-Delete-Delete Test Point (D Code)

Button:  then 

Key: None
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To Delete Test Points from Pads of Current D Code in Frame:
1. Position the Frame around a group of pads from which you want to delete test points.

2. On the Edit  menu, click Test Point-Delete-Delete Test Point (D Code).

Delete Test Points from Pads of Current D Code in Frame

3. On the Delete Test Point dialog, select Group and select D Code.

4. Click OK .

The Delete Test Point tool is selected, and ProbeMaster prompts you to select an element.

5. Position the cursor in a pad that has the D Code from which you want to delete test points.

6. Click  the mouse or press Enter.

The cursor hops to the test point in the pad, and the test point is marked with a green cross. The
D Code of the pad becomes the current D Code shown in the Status Bar.

7. Click  the mouse or press Enter.

ProbeMaster deletes test points from all the pads within the Frame that have the current D Code.

The Delete Test Point tool remains selected until you select another tool or press the Escape key,
so you can delete test points from pads of one D Code after another before quitting the operation.

Menu: Edit-Test Point-Delete-Delete Test Point (D Code)

Button:  then 

Key: None



Chapter 9 Adding Test Points

89

To Delete Test Points from Pads of a Single Net inside the Frame:
1. Position the Frame around a group of pads from which you want to delete test points.

2. On the Edit  menu, click Test Point-Delete-Delete Test Point (Net).

Delete Test Points from a Single Net

3. On the Delete Test Point by Net dialog, select Single and select whether to delete on only the
Current  board side or Both sides.

4. Select whether to keep one test point in each net for which you delete test points, or to delete
all test points in each net.

5. Click OK .

The Delete Test Point tool is selected, and ProbeMaster prompts you to select an element.

6. Position the cursor in a pad of the net from which you want to delete test points.

7. Click  the mouse or press Enter.

The cursor hops to the center of the pad, and the Net Number of the pad becomes the current Net
Number shown in the Status Bar.

8. Click  the mouse or press Enter.

ProbeMaster deletes test points in all pads inside the Frame that have the current Net Number .

The Delete Test Point tool remains selected until you select another tool or press the Escape key,
so you can delete test points from one net after another before quitting the operation.

Menu: Edit-Test Point-Delete-Delete Test Point (Net)

Button: None

Key: None
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To Delete Test Points from a Group of Nets in the Frame:
1. Position the Frame around a group of pads that all belong to the nets from which you want to

delete test points.

Note: The Frame establishes which nets will have test points deleted, not which pads. Every net
that has a pad inside the Frame will have test points deleted from pads that are both
inside and outside the Frame.

2. On the Edit  menu, click Test Point-Delete-Delete Test Point (Net).

Delete Test Points from a Group of Nets in the Frame

3. On the Delete Test Point by Net dialog, select Group and select whether to delete on only
the Current  board side or Both sides.

4. Select whether to keep one test point in each net for which you delete test points, or to delete
all test points in each net.

5. Click OK .

6. Click  the mouse or press Enter.

ProbeMaster deletes test points from all pads that have the same Net Number as the pads inside
the Frame.

Menu: Edit-Test Point-Delete-Delete Test Point (Net)

Button: None

Key: None
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Transferring Test Points to other Side of Board
ProbeMaster allows you to transfer a single through-hole test point or a group of through-hole test
points selected by the Frame to the other side of the board. If you are doing a dual sided test, this can
help to alleviate density problems by moving a test point from the denser side to the less dense side.

To Transfer a Single Through-Hole Test Point to the Opposite Side:
1. On the Edit  menu, click Test Point-Xfer Thru Hole Test Point.

Transfer a Single Through-Hole Test Point to the Opposite Side

2. On the Transfer Test Point dialog, select Single.

3. Click OK .

The Transfer Test Point tool is selected, and ProbeMaster prompts you to select an element.

4. Position the cursor near a through hole test point that you want to transfer to the other side of
the board.

5. Click  the mouse or press Enter.

The cursor hops to the test point and marks it with a green cross.

6. Click  the mouse or press Enter.

The test point transfers to the other side of the board.

The Transfer Test Point tool remains selected until you select another tool or press the Escape
key, so you can transfer one test point after another before quitting the operation.

Menu: Edit-Test Point-Xfer Thru Hole Test Point

Button: None

Key: None
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To Transfer All Through-Hole Test Points in the Frame to the Opposite Side:
1. Position the Frame around the through-hole test points you want to transfer to the other side

of the board.

2. On the Edit  menu, click Test Point-Xfer Thru Hole Test Point.

Transfer All Through-Hole Test Points in the Frame to the Opposite Side

3. On the Transfer Test Point dialog, select Group.

4. Click OK .

5. Click  the mouse or press Enter.

ProbeMaster transfers all through-hole test points within the Frame to the other side of the board.

The Transfer Test Point tool does not remain selected.

Menu: Edit-Test Point-Xfer Thru Hole Test Point

Button: None

Key: None
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Staggering Test Points
ProbeMaster can stagger test points for rectangular surface-mount pads and for through-hole pads.
There are automatic features for staggering groups of test points, or you can stagger individual test
points manually.

Why Stagger Surface-Mount Pads?
By staggering test points for rectangular surface-mount pads, you can relieve some of the problems of
testing dense boards; however, this feature is more useful for fixture-based testers than for moving
probe testers. The feature is more commonly used in FixMaster than in ProbeMaster.

Why Stagger Through-Hole Pads?
By staggering test points for through-hole pads, you can have the probe hit the pad instead of the hole.
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Distance a Test Point is Staggered
The distance a test point is staggered depends on the probe that is associated with that test point. Each
Probe Code has a Margin  value that determines the distance that test points associated with that Probe
Code will be staggered. For information on the other entries on the Probe Setup dialog, see Setting up
the Probes on page 49.

To Set up the Probe Stagger Margin:
1. Set the Current Board Side.

2. Click Setup-Probe Table.

Probe Setup Table

3. On the Probe Setup Table, enter a Margin  for each probe.

Margin for Surface-Mount Pads
For surface-mount pads, the Margin is measured from the end of the pad. So a staggered test point will
be positioned at a distance from the end of the pad that is equal to the Margin.

Margin for Through-Holes
For through-hole pads, the Margin  is measured outward from the hole center or inward from the hole
edge, as selected on the Stagger dialog. In order to stagger a test point beyond the edge of the hole and
probe the covering pad, the Margin factor should be negative, and the distance should be measured
from the edge of the hole.
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Surface-Mount Pads Stagger Options
Options for how to stagger test points for surface-mount pads are set on the SMD tab of the Stagger
Setup dialog. This dialog can be displayed by clicking Setup-Test Point-Stagger, but it is also
displayed in many of the procedures for staggering described in the sections that follow.

Stagger Setup SMD Tab

Stagger Threshold
Enter a minimum pad size to determine which rectangular surface-mount pads will have staggered test
points. Any rectangular SMD pad with a side less than or equal to the Stagger Threshold value will
have its test point staggered.

Two/Three-Point Stagger
Select the option for either a two-point or three-point stagger. A two-point stagger puts a test point at
either of the two extremes of the pad. A three-point stagger puts a test point at either of the two
extremes of the component or in the middle of the component.
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Through Hole Stagger Options
Options for staggering test points for through-hole pads are set on the Hole Stagger From tab of the
Stagger Setup dialog. This dialog can be displayed by clicking Setup-Test Point-Stagger, but it is
also displayed in many of the procedures for staggering described in the sections that follow.

Stagger Setup Dialog, Hole Stagger From Tab

Hole Stagger To
Select the direction to stagger through-hole test points toward.

• None: Do not stagger through-hole test points.

• Top: Stagger through-hole test points toward the top of the pad.

• Bottom: Stagger through-hole test points toward the bottom of the pad.

• Left:  Stagger through-hole test points toward the left of the pad.

• Right:  Stagger through-hole test points toward the right of the pad.

• Random: Randomly staggers test points to the top, bottom, left and right.
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Hole Stagger From
Select where to measure the stagger distance from.

• Center: Stagger by a distance measured from the hole center point.

• Edge: Stagger by a distance measured from the hole edge.

• Auto Annular Displacement: For netlists that also contain covering pad data for through
holes in addition to the hole size, test points for through holes can also be automatically
staggered to a point midway between the hole edge and the covering pad edge.

Hole Min and Max
Set the minimum  and maximum size through-hole pads for which you want to stagger test points.
Through-holes smaller than the minimum or larger than the maximum will not have test points
staggered.
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Staggering All Test Points Automatically
ProbeMaster can stagger all surface-mount and through-hole test points on the current board side
automatically.

To Stagger All Test Points Automatically:
1. Set the Current Board Side.

2. You may have already set up the Probe Code parameters in the tester configuration
procedures.

If not, click Setup-Probe Table and set up the Margin  for each probe. See Distance a Test Point
is Staggered on page 94.

The distance a test point is staggered is equal to the Margin for the Probe Code mapped to the
staggered test point.

• Surface-Mount Pads: The Margin is measured from the end of the pad.

• Through-Holes: The Margin  is measured outward from the hole center or inward from
the hole edge, as selected on the Stagger dialog. In order to stagger a test point beyond
the edge of the hole and probe the covering pad, the Margin  factor should be negative,
and the distance should be measured from the edge of the hole.

3. On the Edit  menu, click Test Point-Stagger-All.

4. On the SMD tab of the Stagger dialog, set options for staggering test points for surface-
mount pads:

Stagger Threshold: Enter a pad size minimum to determine which rectangular surface-mount
pads will have staggered test points. Any rectangular SMD pad with a side less than or equal to the
Stagger Threshold value will have its test point staggered.

Stagger: Select the option for either a two-point or three-point stagger. A two-point stagger puts
a test point at either of the two extremes of the pad. A three-point stagger puts a test point at either
of the two extremes of the component or in the middle of the component.

5. On the Hole Stagger From tab of the Stagger dialog, set options for staggering test points for
through-hole pads:

Hole Stagger To: Select the direction to stagger through-hole test points toward.

• None: Do not stagger through-hole test points.

• Top: Stagger through-hole test points toward the top of the pad.

• Bottom: Stagger through-hole test points toward the bottom of the pad.

• Left:  Stagger through-hole test points toward the left of the pad.

• Right:  Stagger through-hole test points toward the right of the pad.

• Random: Randomly staggers test points to the top, bottom, left and right.
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Hole Stagger From: Select where to measure the stagger distance from.

• Center: Stagger by a distance measured from the hole center point.

• Edge: Stagger by a distance measured from the hole edge.

• Auto Annular Displacement: For netlists that also contain covering pad data for through
holes in addition to the hole size, test points for through holes can also be automatically
staggered to a point midway between the hole edge and the covering pad edge.

Hole Min and Max:  Set the minimum  and maximum size through-hole pads for which you
want to stagger test points. Through-holes smaller than the minimum or larger than the maximum
will not have test points staggered.

6. Click OK .

ProbeMaster automatically staggers the test points as you specified.

7. If you need to stagger test points for the opposite side of the board, repeat the procedure.

Menu: Edit-Test Point-Stagger-All

Button:

Key: Ctrl+Shift+F9
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Manually Staggering Individual Test Points
ProbeMaster allows you to manually stagger individual surface-mount test points on the current board
side.

To Manually Stagger Individual Test Points:
1. Set the Current Board Side.

2. You may have already set up the Probe Code parameters in the tester configuration
procedures.

If not, click Setup-Probe Table and set up the Margin  for each probe.

The distance a test point is staggered is equal to the Margin for the Probe Code mapped to the
staggered test point.

• Surface-Mount Pads: The Margin is measured from the end of the pad.

• Through-Holes: The single stagger operation does not stagger test points for through
holes.

3. On the Setup menu, click Test Point-Stagger.

4. On the SMD tab of the Stagger dialog, set options for staggering test points for surface-
mount pads:

Stagger Threshold: Enter a pad size minimum to determine which rectangular surface-mount
pads will have staggered test points. Any rectangular SMD pad with a side less than or equal to the
Stagger Threshold value will have its test point staggered.

Stagger: Select the option for either a two-point or three-point stagger. A two-point stagger puts
a test point at either of the two extremes of the pad. A three-point stagger puts a test point at either
of the two extremes of the component or in the middle of the component.

5. The single stagger operation does not stagger test points for through holes, so the settings on
the Hole Stagger From tab of the Stagger dialog are unimportant.

6. Click OK .

7. On the Edit  menu, click Test Point-Stagger-Single.

8. Click on the Test Point you want to stagger.

9. Click on the stagger position that you want to move the test point to, at either of the two
extremes of the component or in the middle of the component.

ProbeMaster staggers the test point to the position you specified.

Menu: Edit-Test Point-Stagger-Single

Button: None

Key: Shift+F9
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Staggering Test Points in the Frame
ProbeMaster can stagger all surface-mount and through-hole test points on the current board side
inside the Frame.

To Stagger Test Points in the Frame:
1. Set the Current Board Side.

2. You may have already set up the Probe Code parameters in the tester configuration
procedures.

If not, click Setup-Probe Table and set up the Margin  for each probe.

The distance a test point is staggered is equal to the Margin for the Probe Code mapped to the
staggered test point.

• Surface-Mount Pads: The Margin is measured from the end of the pad.

• Through-Holes: The Margin  is measured outward from the hole center or inward from
the hole edge, as selected on the Stagger dialog. In order to stagger a test point beyond
the edge of the hole and probe the covering pad, the Margin  factor should be negative,
and the distance should be measured from the edge of the hole.

3. Position the Frame around the test points that you want to stagger.

4. On the Edit  menu, click Test Point-Stagger-Window.

5. On the SMD tab of the Stagger dialog, set options for staggering test points for surface-
mount pads:

Stagger Threshold: Enter a pad size minimum to determine which rectangular surface-mount
pads will have staggered test points. Any rectangular SMD pad with a side less than or equal to the
Stagger Threshold value will have its test point staggered.

Stagger: Select the option for either a two-point or three-point stagger. A two-point stagger puts
a test point at either of the two extremes of the pad. A three-point stagger puts a test point at either
of the two extremes of the component or in the middle of the component.

6. On the Hole Stagger From tab of the Stagger dialog, set options for staggering test points for
through-hole pads:

Hole Stagger To: Select the direction to stagger through-hole test points toward.

• None: Do not stagger through-hole test points.

• Top: Stagger through-hole test points toward the top of the pad.

• Bottom: Stagger through-hole test points toward the bottom of the pad.

• Left:  Stagger through-hole test points toward the left of the pad.

• Right:  Stagger through-hole test points toward the right of the pad.

• Random: Randomly staggers test points to the top, bottom, left and right.
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Hole Stagger From: Select where to measure the stagger distance from.

• Center: Stagger by a distance measured from the hole center point.

• Edge: Stagger by a distance measured from the hole edge.

• Auto Annular Displacement: For netlists that also contain covering pad data for through
holes in addition to the hole size, test points for through holes can also be automatically
staggered to a point midway between the hole edge and the covering pad edge.

Hole Min and Max:  Set the minimum  and maximum size through-hole pads for which you
want to stagger test points. Through-holes smaller than the minimum or larger than the maximum
will not have test points staggered.

7. Click OK .

ProbeMaster staggers the test points inside the Frame as you specified.

Menu: Edit-Test Point-Stagger-Window

Button: None

Key: None

Swapping the Stagger Position of Staggered Points in the Frame
ProbeMaster can swap the stagger position of staggered test points for surface mount pads on the
current board side in the Frame.

To Swap the Stagger Position of Staggered Test Points in the Frame:
1. Set the Current Board Side.

2. Position the Frame around the staggered test points for which you want to swap stagger
positions.

3. On the Edit  menu, click Test Point-Stagger-Swap Stagger.

ProbeMaster swaps the stagger position of all staggered test points for surface mount pads inside
the Frame. Staggered test points that were at one end of the pad are staggered to the other end.
Test points in the center of the pad remain there.

Menu: Edit-Test Point-Stagger-Swap Stagger

Button: None

Key: Ctrl+F9
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Window Stagger with Margin
This command staggers a group of test points inside the Frame using a new Margin  value, without
resetting the margin in the Probe Setup dialog. For information about staggering a group of test points
in the Frame without setting a unique Margin  value, see Staggering Test Points in the Frame on page
101. For information about setting the Margin  value on the Probe Setup dialog, see Setting up the
Probes on page 49.

To Stagger Test Points in the Frame:
1. Set the Current Board Side.

2. Position the Frame around the test points that you want to stagger.

3. On the Edit  menu, click Test Point-Stagger-Window Stagger with Margin.

Stagger Margin

4. In the Margin  dialog, enter the new Margin .

The distance a test point is staggered is equal to the Margin .

• Surface-Mount Pads: The Margin  is measured from the end of the pad.

• Through-Holes: The Margin  is measured outward from the hole center or inward from
the hole edge, as selected on the Stagger dialog. In order to stagger a test point beyond
the edge of the hole and probe the covering pad, the Margin  factor should be negative,
and the distance should be measured from the edge of the hole.

5. Click OK .

ProbeMaster staggers the test points inside the Frame as you specified.

Menu: Edit-Test Point-Stagger-Window Stagger with Margin

Button: None

Key: None
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Chapter 10
Checking for Collision Errors

ProbeMaster has the ability to check the job for probe collisions. These errors depend on the probe
head diameters and air gaps set up in the Probe Table. See Setting up the Probes on page 49. On
screen, collisions are displayed in yellow.

Collision errors in ProbeMaster are similar to head butts and crossed pins in FixMaster. However, in
fixture-based testing, all the probes are mounted in the fixture and are in contact with the board
simultaneously, so in FixMaster head butts and crossed pins indicate errors that are very likely to cause
a problem with the fixture. In moving probe testing the probes do not touch all the test points
simultaneously, so collision errors in ProbeMaster indicate errors that may cause problems if the two
points in error are actually going to be probed at the same time. Most testers run their own routines to
avoid collisions, so the ProbeMaster collision checking routine is used primarily to identify stacked
pads and double hits. It is also a tool to help visualize the size of the probe tips in relation to the pads.

ProbeMaster automatically runs a collision check when you stagger test points. See Staggering Test
Points on page 93. In addition you can run a collision check at any time.

Running a Collision Check
You can run a collision check on the whole PCB.

To Run a Collision Check on the Whole PCB:
1. Set the Current Board Side

2. On the Action menu, click Collision Check.

ProbeMaster checks for collisions and reports the number of collision errors found. On screen,
collisions are displayed in yellow.

Menu: Action-Collision Check

Button:

Key: None
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Inspecting Collision Errors

Collision Errors

ProbeMaster has a feature that allows you to go to each sequential collision error.

To Inspect Collision Errors:
1. On the View menu, click Go To-Collide.

The Go To Collision Error  tool is selected.

2. Click  the mouse.

The cursor hops to the next collision error. The test point is marked with a green cross, indicating
it is selected. Pads with collision errors are displayed in yellow.

The Go To Collision Error  tool remains selected until you select another tool or press the Escape
key, so you can find one collision error after another by clicking the mouse.

Menu: View-Go To-Collide

Button:

Key: None
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Correcting Collision Errors
There are several manual and automatic techniques for correcting collision errors.

Remove Padstacks to Correct Collisions
Many collision errors are due to stacked pads. Removing stacked pads helps to eliminate stacked test
points that can cause collision errors. See Removing Padstacks on page 174.

Stagger Test Points to Correct Collision Errors
In FixMaster, staggering test points can help to correct crossed pins and head butts, which are similar
to collision errors in ProbeMaster. Sometimes staggering test points in ProbeMaster may prevent
collisions in cases where very close pads are going to be probed simultaneously.

• Stagger Test Points in the Frame: See Staggering Test Points in the Frame on page 101.

• Manually Stagger Individual Test Points: See Manually Staggering Individual Test Points
on page 100.
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Chapter 11
Netlist Inspection Mode

There may be times when you want to view individual nets and edit test points one net at a time. While
the automatic test point generating command and manual test point editing commands allow you to
edit test points with a view of the entire board, Netlist Inspection mode allows you to view individual
nets and edit test points for a single displayed net. This is useful for assuring that each net is tested
properly, and for dealing with special situations such as ring nets.

The normal command menus are not available in Netlist Inspection mode. You use the commands on
the Netlist Inspection toolbar and some special keyboard commands. Netlist Inspection mode has
some unique commands for locating and displaying specific nets. Many of the Netlist Inspection
mode commands for editing test points are the same as the test point editing commands in the normal
editing mode; however, there are some unique commands also.

Netlist Inspection Toolbar

Netlist Inspection Toolbar
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Color System in Netlist Inspection Mode
To aid in the netlist inspection process, ProbeMaster uses the following color system to identify
specific elements in Netlist Inspection mode.

• Green Pads: Solder Side SMD

• Gray Pads: Component Side SMD

• Yellow Traces: Solder Side Traces

• Gray Traces: Component Side Traces

• Blue Traces: Internal Traces

• Yellow +: Solder Side Test Point

• Gray X:  Component Side Test Point

Netlist Inspection Mode Color System

Green Pad:  Solder Side SMD

Yellow +:  Solder Side Test Point

Yellow Trace:  Solder Side SMD

Gray Pads:  Comp. Side SMD

Gray Trace:  Comp. Side Trace

Gray X:  Comp. Side Test Point
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Entering and Exiting Netlist Inspection Mode
Netlist Inspection mode is a separate editing mode from the normal editing mode.

To Enter Netlist Inspection Mode:
� On the Action menu, click Inspect Netlist.

Menu: Action-Inspect Netlist

Button:

Key: None

To Exit Netlist Inspection Mode and Return to Normal Editing:
� On the Netlist Inspection toolbar, click the Exit  button.

Or

� On the Netlist Inspection mode Action menu, click Quit .

Menu: Action-Quit

Button:

Key: None
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Displaying Nets
Netlist Inspection mode has several options for displaying nets.

Displaying a Specific Net
You can select a specific net to display.

To Display a Specific Net:

1. On the Netlist Inspection toolbar, click the Display a Net  button.

ProbeMaster prompts you for a net number.

Display a Specific Net

2. Type the net number of the net you want to inspect and click OK .

ProbeMaster displays the selected net and adjusts the zoom level so that the selected net fills the
screen. In the message area of the Status Bar, ProbeMaster displays the net number and the
number of pads in the net, for the current board side.

Menu: None

Button:

Key: None



Chapter 11 Netlist Inspection Mode

113

Displaying the First, Next or Previous Net in the File
ProbeMaster has commands to display nets in numerical order according to their net numbers in the
file. You can display the first net in the file or the next or previous net. When ProbeMaster displays the
selected net, the program adjusts the zoom level so that the net fills the screen. In the message area of
the Status Bar, ProbeMaster displays the net number and the number of pads in the net, for the current
board side.

To Display the First, Next or Previous Net in the File:

� On the Netlist Inspection toolbar, click the First Net , the Next Net   or the

Previous Net   button.

Menu: None

Button:  or  or 

Key: Shift+F or Shift+N. or Shift+B
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Displaying Nets that Do Not Have Enough Test Points
Multi-point nets can sometimes end up with only one test point because of the options selected when
automatically generating test points. For instance, the pads on ring nets which are connected by traces
that form a closed loop or pads on filled areas which are intersected by many fill traces may not
receive test points if you are only generating test points for endpoints. Such nets cannot be tested
properly for continuity. In some cases a net may not have any test points. Such nets cannot be tested
for shorts to other nets. ProbeMaster has a command that allows you to identify nets that have less than
one or two test points.

You select whether to find nets that do not have at least one test point or to find nets that do not have at
least two test points. When the command is activated, ProbeMaster displays the next net that has less
than the designated number of test points and adjusts the zoom level so that the selected net fills the
screen. In the message area of the Status Bar, ProbeMaster displays the net number and the number of
pads in the net, for the current board side. When the net is displayed, you can decide whether to add a
test point.

ProbeMaster also has a command for automatically generating test points for some of these nets. See
Adding Test Points to Nets that Do Not Have Enough Test Points on page 121. If you identify a large
number of these nets, then rather than manually adding test points, you may want to have ProbeMaster
try to generate test points for them. Then you can manually correct any remaining nets with too few
test points.

To Displaying Nets that Do Not Have Enough Test Points:
1. To set up the operation you need to be in the regular editing mode, so if you are already in

Netlist Inspection mode, exit by clicking the Exit  button on the Netlist Inspection toolbar.

2. In the regular editing mode, go to the Setup menu and click Configuration .

General Configuration Dialog
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3. On the General Configuration dialog, go to the group box labeled Define No TP Nets as
Nets With, and set the number of test points to look for in each net:

• No Test Points: If this option is selected, the No TP Nets command will display only
nets that do not have at least one test point.

• Less Than 2 TP: If this option is selected, the No TP Nets command will display nets
that do not have at least two test points.

4. Enter Netlist Inspection mode by going to the Action menu and clicking Inspect Netlist.

5. On the Netlist Inspection toolbar, click the No TP Nets  button.

ProbeMaster displays the first sequential net with less than the designated number of test points
and adjusts the zoom level so that the selected net fills the screen. In the message area of the
Status Bar, ProbeMaster displays the net number and the number of pads in the net, for the
current board side. ProbeMaster also displays the total number of nets with less than the specified
number of test points.

6. To display the next sequential net with less than the designated number of test points click the

No TP Nets  button again.

Menu: None

Button:

Key: None
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Options for How to Display Nets
Displaying Test Points with a Large X

ProbeMaster has a command to display a large X mark at each test point, making test points easier to
spot. This feature can be turned off by activating the command a second time.

To Toggle the Display of a Large X at Each Test Point:

� On the Netlist Inspection toolbar, click the Toggles TP  button.

Menu: None

Button:

Key: None



Chapter 11 Netlist Inspection Mode

117

Test Points Shown with the Large X Turned Off

Test Points Shown with the Large X Turned On
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Inspecting Ring Nets
Ring nets are nets in which traces form closed loops. Filled areas generally form ring nets. Pads on the
ring portion of the net may be designated as midpoints during netlist extraction. If you generate test
points for endpoints only, then you will not be testing the ring portion of the net for continuity.
ProbeMaster gives you two ways to display ring nets for inspection.

Checking Nets With Less Than One or Two Test Points to Find Rings
You can sequentially inspect all nets that have less than one or two test points, as explained earlier. See
Displaying Nets that Do Not Have Enough Test Points on page 114. This command will display many
ring nets, along with other nets that are not rings. The advantage to this method is that it does not
require any time-consuming preprocessing to identify ring nets. The disadvantage is that it shows you
some nets that are not ring nets, and it will not show you nets that have many endpoints but also have a
ring portion. Still, this is generally the method that most people prefer.
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Display Ring Net Command
ProbeMaster has a command that displays the next sequential ring net. The advantage to this method is
that it will show you all ring nets, even those that do have a few endpoints, and it does not show you
any nets that are not ring nets. The disadvantage is that before using this feature you must first run an
operation to identify all of the ring nets in the loaded data, and that operation can take some time. Most
people generally prefer the other method.

To Display Ring Nets:
1. To run the operation that identifies the ring nets, you need to be in the regular editing mode,

so if you are already in Netlist Inspection mode, exit by clicking the Exit   button on the
Netlist Inspection toolbar.

2. In the regular editing mode, go to the Action menu and click Ring Net.

Max Traces Dialog

3. On the Max Traces dialog, enter the largest size net you want to check for ring nets. Nets
that have more traces than the Max Traces value are not checked.

4. Click OK .

ProbeMaster identifies all of the ring nets in the loaded data. This can take a little while.

5. Enter Netlist Inspection mode by going to the Action menu and clicking Inspect Netlist.

6. On the Netlist Inspection toolbar, click the Ring  button.

ProbeMaster displays the first sequential ring net and adjusts the zoom level so that the selected
ring net fills the screen. In the message area of the Status Bar, ProbeMaster displays the net
number and the number of pads in the ring net, for the current board side.

7. To display the next sequential ring net, click the Ring  button again.

Menu: None

Button:

Key: None



ProbeMaster User’s Guide

120

Editing Test Points in Netlist Inspection Mode
Many of the Netlist Inspection mode commands for editing test points are the same as the test point
editing commands in the normal editing mode; however, there are some unique commands also.

Switching the Active Board Side in Netlist Inspection Mode
You can switch the active board side between the component side and the solder side. The active side
is shown in the Status Bar, CMP and SOL. Unlike in the normal editing mode, both sides of the
board are shown in Netlist Inspection mode; however, commands for selecting or editing pads or test
points still operate only on elements in the active board side.

To Switch the Active Side between Component Side and Solder Side:

� In the Status Bar, click the Active Side  button.

Menu: None

Button:

Key: None

Selecting a Test Point or Pad in Netlist Inspection Mode
Selecting an element causes the cursor to hop to the nearest element, and the D Code, net number and
probe number of the selected element is displayed on the Status Bar.

To Select a Pad or Test Point:
� Position the cursor next to the test point or pad and press the S key.

Menu: None

Button: None

Key: S

Inserting Test Points in Netlist Inspection Mode
You can insert individual test points for single pads, groups of test points for all pads within the Frame,
or groups for pads of a selected D Code within the Frame. These commands are operated just as in the
normal editing mode except that they are activated from the Netlist Inspection toolbar by clicking the

Insert TP  button. See Inserting Test Points on page 81.

Menu: None

Button:

Key: None
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Deleting Test Points in Netlist Inspection Mode
You can delete individual test points one at a time, delete groups of all test points within the Frame, or
delete groups of test points from pads of a selected D Code within the Frame. These commands are
operated just as in the normal editing mode except that they are activated from the Netlist Inspection

toolbar by clicking the Del TP  button.  See Deleting Test Points on page 86.

Menu: None

Button:

Key: None

Adding Test Points to Nets that Do Not Have Enough Test Points
Netlist Inspection mode has a unique command that can be used to correct ring nets and other nets
that do not have enough test points to test for continuity.

This command overrides the test point generation options set on the Generate Config dialog when you
are automatically generating test points, and it allows ProbeMaster to add test points to nets that have
less than two test points.

This command also has a unique feature that determines if a net endpoint is covered by soldermask,
and if so, it searches the net for an open test point.

The command is a global command that affects some of the nets that you could eventually inspect by
clicking the No TP Nets command. It does not affect only the one net that can be displayed in Netlist
Inspection mode.

To Add Test Points to Nets that Do Not Have Enough Test Points:

� On the Netlist Inspection toolbar, click the Add TP to NTP  button.

Menu: None

Button:

Key: None
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Chapter 12
Net Adjacency

Some moving probe testers use net adjacency data for more efficient testing. The adjacency
information tells the tester which nets are “next to” each other, and the tester does not need to test for
faults between nets that are not adjacent.

If you generated the netlist data using Lavenir’s CAMMaster, and you selected the adjacency option,
then the netlist already contains the adjacency information. Also, the IPC-356-A format may contain
adjacency information, so if you import an IPC-356-A file from a netlist generation system that
calculates adjacency, your file may also contain adjacency information.

If your tester uses adjacency information and it is not already contained in the netlist file, then you may
generate the adjacency information in ProbeMaster.

Checking Nets for Adjacency
ProbeMaster can automatically check for net adjacency and compile a file of adjacent nets. Each
element of each net is checked. If two nets have elements that are closer than the adjacency threshold
that you set, then those nets will be included in the adjacency file.

To Run the Net Adjacency Check:
1. On the Setup menu, click Tester.

Tester Setup Dialog

2. In the Minimum Net Separation field, enter the adjacency threshold. Two nets that have
elements closer than this distance are considered to be adjacent.

3. On the Action menu, click Adjacency Nets-Find Nets.
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4. ProbeMaster prompts whether you want to export the test files at the same time that the net
adjacency information is generated.

• If you want to export the test files at the same time the adjacency data is generated, click
Yes, and set up the test file export options. For information on how to set up the export
options, see Exporting Tester Download Files on page 152.

• If you do not want to export the test files, click No.

ProbeMaster checks the nets for adjacency. The process can take a few minutes. ProbeMaster
indicates that the adjacency check is done with a message in the Status Bar.

Menu: Action-Adjacency Nets-Find Nets

Button:

Key: None
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Adjacency Inspection Mode
ProbeMaster allows you to visually inspect adjacent nets in Adjacency Inspection mode. In
Adjacency Inspection mode, ProbeMaster displays any net that you select. And if there are any nets
adjacent to the selected net, ProbeMaster displays the primary net and the first adjacent net and marks
the adjacent elements with a magenta crosshair. In the message area of the Status Bar, ProbeMaster
displays the net numbers of the two nets. ProbeMaster also shows the positions of two adjacent
elements in the units of the database and the distance between the two elements in the units of the
export file. When there are more than one net adjacent to the selected net, you can view each adjacent
pair sequentially.

The normal command menus are not available in Adjacency Inspection mode. You use the commands
on the Adjacency Inspection toolbar and some special keyboard commands. Adjacency Inspection
mode has some unique commands for locating and displaying specific nets.

Adjacency Inspection Toolbar

Adjacency Inspection Toolbar



ProbeMaster User’s Guide

126

Entering and Exiting Adjacency Inspection Mode
Adjacency Inspection mode is a separate inspection mode from the normal editing mode.

To Enter Adjacency Inspection Mode:
1. Before entering Adjacency Inspection mode, run the adjacency check. See Checking Nets

for Adjacency on page 123.

2. On the Action menu, click Adjacency Nets-Inspect Nets.

Menu: Action-Adjacency Nets-Inspect Nets

Button:

Key: None

To Exit Adjacency Inspection Mode and Return to Normal Editing:
� On the Adjacency Inspection toolbar, click the Exit  button.

Or

� On the Adjacency Inspection mode Action menu, click Quit .

Menu: Action-Quit

Button:

Key: None
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Displaying a Specific Adjacency
You can select a specific net for inspection. ProbeMaster will display the selected net and the first
adjacent net if any.

To Display a Specific Net and its Adjacent Net if Any:

1. On the Adjacency Inspection toolbar, click the Net Adjacencies  button.

ProbeMaster prompts you for a net number.

Display a Specific Net

2. Type the net number of the net you want to inspect and click OK .

ProbeMaster displays the selected net and the first adjacent net if any. ProbeMaster adjusts the
zoom level so that both nets fill the screen. In the message area of the Status Bar, ProbeMaster
displays the net numbers of the two nets. ProbeMaster also shows the positions of two adjacent
elements in the units of the database and the distance between the two elements in the units of the
output file. If there is no adjacent net, ProbeMaster shows information for the selected net.

Menu: None

Button:

Key: None
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Displaying the First, Next or Previous Adjacency in the File
ProbeMaster has commands to display adjacencies in numerical order according to the net numbers of
the nets involved. You can display the first, next or previous adjacency in the file. Some nets are not
adjacent to any other nets, and some nets are adjacent to more than one. So the adjacency sequence
begins with the first net number in the file. That first net is the selected net and the system shows that
net and the first net (if any) adjacent to that net. If there are more that one net adjacent to the selected
net, then the next adjacency is the next net adjacent to the selected net, and so on. Once the last net
adjacent to the selected net has been shown, the sequence moves on to the next net number in the file
and the first net (if any) adjacent to that net. By going through this sequence each net and each adjacent
pair can be seen.

To Display the First, Next or Previous Adjacency in the File:

� On the Adjacency Inspection toolbar, click the First Adjacency , the Next Adjacency

  or the Previous Adjacency   button.

Menu: None

Button:  or  or 

Key: Shift+F or Shift+N. or Shift+B

Switching the Active Board Side in Adjacency Inspection Mode
You can switch the active board side between the component side and the solder side. The active side
is shown in the Status Bar, CMP and SOL. Unlike in the normal editing mode, both sides of the
board are shown in Adjacency Inspection mode; however, elements of the active side are shown in
front of elements of the other side.

To Switch the Active Side between Component Side and Solder Side:

� In the Status Bar, click the Active Side  button.

Menu: None

Button:

Key: None
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Chapter 13
Fiducial Points

Most moving probe testers use fiducial points on the board to align the probes. The tester detects the
fiducials on the board, and uses the fiducial locations to calculate the test point locations, correcting for
offset and rotation. So that the fiducial information can be included in the tester download files, you
tag the fiducial points in ProbeMaster before outputting the files. You can tag circuit elements in the
PCB database, or you can enter the locations into a table.

Elements to Use as Fiducials
Different testers can detect different types of fiducials. In general, for testers that use circuit elements
that can be viewed in ProbeMaster, mid-sized plated through holes that do not have any incoming
traces are a good choice. Large non-plated through holes are not as good. Through holes are good for
testers that need fiducials tagged for both sides of the board, because through holes have the same
locations on both sides of the board. ProbeMaster automatically makes the fiducials the same locations
on both sides of the board.

Try to select fiducials that are near the outside edges of the board, but which won’t be obscured by the
clamps. Also be sure to mark the fiducials after stepping and repeating, and pick points at the edges of
the panel, not the edges of the one-up image.

For the MP-440, the center-tooling fiducial must be to the right of the lower-left fiducial and to the left
of the upper-right fiducial.

In some cases you may want to use fiducial points that are not included as elements in the loaded data.
In that case you must enter the fiducial points by typing them into the table rather than by tagging
elements.



ProbeMaster User’s Guide

130

Tagging the Fiducials
To Automatically Tag the Fiducials:
� On the Edit  menu, click Fiducials-Automatic.

ProbeMaster looks for non-connected, plated through holes at the extents of the panel and tags
them as fiducials.

Menu: Edit-Fiducials-Automatic

Button: None

Key: None

To Manually Tag the Fiducials with the Mouse:
1. On the Edit  menu, click Fiducials-Manual.

Fiducials Dialog for MP440

ProbeMaster displays the Fiducials dialog where you tag fiducials in the loaded PCB data for the
currently active board side, CMP or SOL. Because different testers require different numbers of
fiducials, the fiducials table displayed in the dialog depends on the type of tester you set up earlier.
For information on selecting the type of tester, see Selecting the Tester Type on page 47.

2. To manually tag all the fiducials using the mouse, click the Tag checkbox so that it has a
checkmark, and then click OK .

3. Follow the prompts in the Status Bar, which will tell you when to click on each fiducial. Be
sure to tag the fiducials in the proper order as indicated by the prompts. ProbeMaster
automatically makes the fiducials the same locations on both sides of the board.

Menu: Edit-Fiducials-Manual

Button: None

Key: None
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To Manually Type the Fiducial Locations into the Table:
1. On the Edit  menu, click Fiducials-Manual.

Fiducials Dialog

ProbeMaster displays the Fiducials dialog where you set up fiducials for the currently active
board side, CMP or SOL. Because different testers require different numbers of fiducials, the
fiducials table displayed in the dialog depends on the type of tester you set up earlier. For
information on selecting the type of tester, see Selecting the Tester Type on page 47.

2. Type in all the fiducial locations in the table.

3. Be sure to click the Tag checkbox so that it has no checkmark. If the Tag checkbox has a
checkmark when the dialog is closed, ProbeMaster will prompt you to manually tag the
fiducials with the mouse.

4. Click OK .

Menu: Edit-Fiducials-Manual

Button: None

Key: None
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Displaying the Fiducials
After you have tagged the fiducials, you can have ProbeMaster display them for your inspection.

To Display the Fiducials:
1. On the View menu, click Data Elements-Fiducials.

Display the Fiducials

ProbeMaster displays the same fiducial table you see when you set up the fiducials; however, this
dialog does not give you the option to tag the fiducials manually.

2. Click OK .

ProbeMaster displays a magenta X at all the fiducial points.

3. Click the mouse to go to each fiducial point in sequence.

ProbeMaster identifies each fiducial and displays its location in the message area of the Status
Bar.

Menu: View-Data Elements-Fiducials

Button: None

Key: None
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Chapter 14
Testing Dense Components Separately

There is a feature in ProbeMaster for testing densely packed components separate from the rest of a
PCB. The Isolated Component Test feature allows for an efficient way to completely test the nets
associated with a densely packed component in two different jobs. Generally this is used when a dense
part is going to be tested on a moving probe tester and the rest of the board is going to be tested
separately on a universal tester. This feature allows you to prepare part of the board in ProbeMaster
and part of the board in FixMaster. Also this feature is included in both ProbeMaster and FixMaster, so
you can begin in either program.

In jobs where the Isolated Component Test feature can be useful, test points inside the densely packed
component belong to nets that also have test points in less densely packed areas. All the test points that
are inside the densely packed area are tested using a moving probe. While all the test points that are
outside the densely packed area are tested separately on a fixture-based tester. For every net that has a
test point inside the densely packed area, one test point in that net that is outside the densely packed
area is also tested. That test point is the “bridge” between the two jobs because it is tested with the
densely packed region, and it is also tested along with the rest of the PCB. The Isolated Component
Test feature generates the “bridge” test points for the densely packed component.

Note: The Isolated Component Test feature is not a Split Net operation like those in FixMaster
because ProbeMaster does not generate the two split jobs. You must save the two jobs
separately. In one job you generate test points for all but the densely packed component, and
in the other job you generate test points for the component and then use the Isolated
Component Test feature to generate the “bridge” test points outside the component.
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To Insert “Bridge” Test Points for a Single Net in a Densely Packed Component:
1. Position the Frame around the densely packed component.

2. On the Action menu, click Iso Component Generate.

Isolate Component Test Dialog

3. On the Isolate Component Test dialog, select Single.

4. In the Outside Frame group box, select whether to generate only one test point outside the
Frame, or to generate test points for all endpoints of the selected net.

• Tag One Test Point: If this option has a checkmark, then the command will generate
only one test point outside the Frame for the selected net. This is the recommended
option.

• Tag All Endpoints: If this option has a checkmark, then the command will generate test
points for all endpoints of the selected net.

5. Click OK .

ProbeMaster prompts you to select an element.

6. Click inside a pad of the component that belongs to the net that you want to generate a
“bridge” test point for.

ProbeMaster inserts test points in the pads of the selected net that are inside the Frame. And if the
net has pads outside the Frame, ProbeMaster also inserts a test point in one (or all endpoints)
outside the Frame.

Menu: Action-Iso Component Generate

Button: None

Key: None
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To Insert “Bridge” Test Points for All Nets in a Densely Packed Component:
1. Position the Frame around the densely packed component.

2. On the Action menu, click Iso Component Generate.

Isolate Component Test Dialog

3. On the Isolate Component Test dialog, select Group and select All.

4. In the Outside Frame group box, select whether to generate only one test point outside the
Frame, or to generate test points for all endpoints of the selected net(s).

• Tag One Test Point: If this option has a checkmark, then the command will generate
only one test point outside the Frame for the selected net(s). This is the recommended
option.

• Tag All Endpoints: If this option has a checkmark, then the command will generate test
points for all endpoints of the selected net(s).

5. Click OK .

6. Click inside the Frame.

ProbeMaster inserts test points in all the pads inside the Frame. And if the nets of the component
have pads outside the Frame, then for each net ProbeMaster also inserts a test point in one pad (or
all endpoints) outside the Frame.

Menu: Action-Iso Component Generate

Button: None

Key: None
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To Insert “Bridge” Test Points for Nets with a Specific D Code in a Densely Packed
Component:
1. Position the Frame around the densely packed component.

2. On the Action menu, click Iso Component Generate.

Isolate Component Test Dialog

3. On the Isolate Component Test dialog, select Group and select D Code.

4. In the Outside Frame group box, select whether to generate only one test point outside the
Frame, or to generate test points for all endpoints of the selected net(s).

• Tag One Test Point: If this option has a checkmark, then the command will generate
only one test point outside the Frame for the selected net(s). This is recommended.

• Tag All Endpoints: If this option has a checkmark, then the command will generate test
points for all endpoints of the selected net(s).

5. Click OK .

6. Click a pad inside the Frame that has the D Code you want to select.

The cursor hops to the pad and it’s D Code becomes the current D Code shown in the Status Bar.

7. Click again.

ProbeMaster inserts test points in all the pads inside the Frame that have the selected D Code. And
if the nets of the component have pads outside the Frame, then for each net ProbeMaster also
inserts a test point in one pad (or all endpoints) outside the Frame.

Menu: Action-Iso Component Generate

Button: None

Key: None
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Chapter 15
File Handling in ProbeMaster

The ProbeMaster Job File (.JOB) is the native file format for ProbeMaster and contains all information
regarding the current state of the database and program settings. The .JOB file is the only file type that
the program Opens and Saves. However the program can Import other file types into the open .JOB
file and Export other file types from the .JOB file.

ProbeMaster Job File (.JOB) Overview
The Job File (.JOB) is the native file format for ProbeMaster and contains all information regarding the
current state of the database and operation settings:

Tester Configuration:

• Tester Type

• Probe Diameters

• Probe Air Gaps

• Probe Margins

Operation Variables:

• D Code and Probe Mapping

• Test Point Generation Options

• Stagger Options

• Adjacency Options

PCB database:

• Pads, Traces, Netlist Data

• Test Points

• Fiducials

Boilerplate Job Files
.JOB files can be used as boilerplate test configuration files that can be saved and reopened when you
have similarly configured jobs. A boilerplate .JOB file is saved with the tester configuration and
operation variables, before the PCB database is loaded.
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FixMaster and Verify Job Files
ProbeMaster .JOB files can also be opened in the Lavenir product Verify. And ProbeMaster can open
.JOB files saved in the Lavenir product FixMaster.

Generally the FixMaster .JOB files that are opened in ProbeMaster are those that are saved after a Split
Net operation, and they contain nets that have been split out for testing on a moving probe tester. For
more information on splitting nets, see the Spit Net chapter in the FixMaster User’s Guide.

ProbeMaster and FixMaster .JOB files of completed jobs can be opened in Verify for fault verification.

Starting a New ProbeMaster Job
The New command creates a new .JOB file that has nothing in it and is ready to have other files
imported into it or to have data inserted into it. The program can only have one .JOB file open at a
time; so, if a different .JOB file is already open when you start a new .JOB file, then the program
prompts to give you an opportunity to save the existing .JOB file before starting the new .JOB file.

To Start a New ProbeMaster Job:
1. On the File menu, click New.

ProbeMaster may prompt, “Are you sure?” This prompt is to warn you that you are about to close
the currently opened .JOB file and open a new one. This gives you an opportunity to save the
existing .JOB file before starting the new .JOB file

New File Prompt

2. Click Yes.

The newly created ProbeMaster .JOB file has nothing in it.

Menu: File-New

Button:

Key: Ctrl+N
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Opening a ProbeMaster Job File
The Open command opens a previously saved .JOB file. The program can only have one .JOB file
open at a time; so, if a different .JOB file is already open when you open another .JOB file, then the
program prompts to give you an opportunity to save the existing .JOB file before opening the new
.JOB file.

Tip: To open a .JOB file you've used recently, click the file name on the Recent Files List at the
bottom of the File menu.

To Open a ProbeMaster Job:
1. On the File menu, click Open.

Open File Dialog

2. In the Look in box, click the drive, folder, or network location that contains the .JOB file.

3. In the folder list, double-click folders until you open the folder that contains the .JOB file you
want.

4. Double-click the .JOB file.
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ProbeMaster may prompt, “Are you sure?” This prompt is to warn you that you are about to close
the currently opened .JOB file and open a new one. This gives you an opportunity to save the
existing .JOB file before opening the new .JOB file.

Open File Prompt

5. Click Yes.

Menu: File-Open

Button:

Key: Ctrl+O
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Closing a ProbeMaster Job File
The program can have one and only one .JOB file open at a time; so, closing the current .JOB file
without opening another one is the same as exiting the program. The Open and New commands
automatically close the current .JOB file; so, if a different .JOB file is already open when you open
another .JOB file, then the program prompts you to save and close the existing .JOB file before
opening the new .JOB file.

To Close a Job File:
1. On the File menu, click Exit .

Closing a .JOB file does not automatically save the .JOB file. ProbeMaster may prompt, “Are you
sure?” This gives you an opportunity to save the .JOB file before closing it.

Close File Prompt

2. Click Yes.

Tip: If you have made a bad mistake in your editing since the last time you saved and you
want to go back to your saved version, close the file without saving and then open the
saved version.

Menu: File-Exit

Button: None

Key: None



ProbeMaster User’s Guide

142

Saving a Job File
There are several ways to save a .JOB file.

To Save a New, Unnamed ProbeMaster Job File:
1. On the File menu, click Save.

Save As Dialog

2. To save the ProbeMaster .JOB file in a different folder, click a different drive in the Save in
box, or double-click a different folder in the folder list.

To save the ProbeMaster .JOB file in a new folder, click Create New Folder.

3. In the File name box, type a name for the .JOB file.

Menu: File-Save

Button:

Key: Ctrl+S
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To Save a Copy of a Job File:
1. On the File menu, click Save As.

Save As Dialog

2. To save the copy in a different folder, click a different drive in the Save in box, or double-
click a different folder in the folder list.

To save the copy in a new folder, click Create New Folder.

3. In the File name box, type a name for the copy.

Menu: File-Save As

Button: None

Key: None
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To Save Work in Progress:
When you have work in progress that you want to save in case of power failure or because you need to
shut down the program, you can save it under the current file name and overwrite the original .JOB
file.

1. To save the open .JOB file under the current file name, go to the File menu, and click Save.

ProbeMaster prompts for whether you want to overwrite the existing file.

Save File Prompt

2. Click OK .

Menu: File-Save

Button:

Key: Ctrl+S
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Importing PCB Files into the Job
The program imports several formats of PCB data, including several netlist formats and supplemental
Gerber files.

Importing IPC-D-356 Formatted Netlist Files into the Job
ProbeMaster imports IPC-D-356 formatted netlists including the Lavenir Format 4 and Format 2
netlists (.F02 and .F04 files). If you want to import another format of netlist you may be able to convert
it to a Lavenir format. See Converting Netlist Files to Lavenir Format on page 148.

To Import IPC-D-356 Formatted Netlist Files into the Job:
1. On the File menu, click Import-Netlist .

Import Netlist File Dialog

2. In the Look in box, click the drive, folder, or network location that contains the netlist file.
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3. In the folder list, double-click folders until you open the folder that contains the netlist file
you want.

4. Click on the netlist file that you want.

5. Click the Options button.

Netlist File Setup Dialog

6. Select whether the incoming data is in English or Metric  units.

7. Format 4 netlists can contain trace data. Select whether to read in the trace data.

• Do Not Ignore: Reads in all traces.

• Ignore All:  Does not read in any traces.

• Ignore Inner:  Reads in component-side and solder-side traces, but does not read in
traces on inner layers.
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8. Select whether the incoming data has Numeric or Alphanumeric IPC Signal ID.

9. Select whether to swap the component-side and solder-side data.

• Clicking this option so that there is a checkmark means ProbeMaster swaps the
component-side and solder-side data. This is not the same as flipping the data. The
orientation of the data remains the same, but the sides are switched.

• Clicking this option so that there is no checkmark means ProbeMaster does not swap
the data. The sides are read in as is.

10. Click OK .

ProbeMaster imports the netlist file, orients the data as you specified, and displays the data on the
screen.

Menu: File-Import Netlist

Button: None

Key: None
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Converting Netlist Files to Lavenir Format
The program can convert many formats of netlist file into Lavenir Format 2 or Format 4 netlists. When
the netlist is converted into a Lavenir format netlist, you can import the netlist into the job.

To Convert a Netlist File:
1. On the Action Menu, click Convert Netlist File.

Convert Netlist Dialog

2. In the Look in box, click the drive, folder, or network location that contains the netlist file.

3. In the folder list, double-click folders until you open the folder that contains the netlist file
you want.

4. Click on the file that you want so that it is highlighted.

5. Pick the netlist type on the Netlist Type drop down list, or click Guess Type.

6. If the file contains N/C records for non-connected points and you want those points to have
unique identifiers, click on Add Numbers to N/C’s so that the option has a checkmark.
If there is no checkmark, then those points will have the N/C identifier with no unique net
number.
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7. If you want to automatically import the converted netlist after conversion, click on Import
Netlist After Conversion so that the option has a checkmark.
If there is no checkmark, then the netlist will be converted and saved under a name you
specify later, but it will not be imported.

8. Click Open.

Depending on the netlist type, the program may prompt for some additional information or files.

The program prompts for a name for the converted netlist file.

9. If you want to accept the default name, click Accept Default.
If you want to change the name or directory, click Change Name, and enter a new name or
location for the converted netlist file. Then click OK .

Menu: Action-Convert Netlist File

Button: None

Key: None
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Importing Supplemental Gerber Files into the Job
ProbeMaster can import supplemental Gerber silkscreen, soldermask, and board outline PCB data.
Gerber files with the Lavenir layer types SKU, SKL, MSU, MSL contain silkscreen and soldermask
data that can be used to determine if pads are exposed and can be probed. Gerber files with the Lavenir
layer type BOL contain board outline data. Before importing the soldermask, silkscreen, or board
outline files, you import a Lavenir environment file containing the D Code values and the layer file
names.

To Import Supplemental Gerber Files into the Job:
1. On the File Menu, click Import-Misc Gerber .

Import Supplemental Gerber Dialog

2. Click the Browse button.
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Browse for .ENV File

You must import the Lavenir environment file (.ENV file) associated with the supplemental
Gerber files before importing the supplemental Gerber.

3. In the Look in box, click the drive, folder, or network location that contains the .ENV file.

4. In the folder list, double-click folders until you open the folder that contains the .ENV file you
want.

5. Click on the .ENV file that you want.

6. Click OK .

7. On the main Import Supplemental Gerber dialog, click the Load Env button.

ProbeMaster imports the environment file. The names of the supplemental Gerber files are added
to the Filename fields.

8. Click in the Load column for each file that you do want to import so that the file has a
checkmark next to it. If you do not want to import a particular file, make sure it has no
checkmark.

9. Click OK .

ProbeMaster imports the supplemental Gerber files.

Menu: File-Import Misc Gerber

Button: None

Key: None
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Exporting Tester Download Files
Export options vary depending on what type of tester is selected.

Exporting MicroCraft MP-440 and Emma Test Files
To Export MicroCraft MP-440 and Emma Test Files:
1. On the File menu, click Export-Test.

2. ProbeMaster displays the Output Test Files dialog for MicroCraft MP-440 and Emma test
files.

Export MP440 Test File

3. Click the Browse button.

4. In the Browse dialog, browse for the file location to which you want to export the file.

5. In the File Name field, enter the name of the file you want to export.

6. On the Browse dialog, click OK .

7. In the Output Format  group box, select whether the exported data is to be in English or
Metric  units.
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8. In the Output Adjacency group box, select what type of adjacency data to export.

• All:  Outputs all adjacency data.

• Selected: Outputs adjacency for nets marked with the Selective Nets command. See
Marking Nets for Separate Export on page 186.

• Error File:  Exports a test file with no adjacency data.

9. In the Version group box, select what version of MP-440 or EMMA test file to export.

• Normal:  This is the recommended version and is the version most commonly used.

• Extended: The extended version is the same as the normal version except that it also
includes adjacency information.

• All Nets: This version is only for special uses. Instead of using the adjacency data
calculated by the adjacency check, this option causes adjacency data to be exported in
such a way that each net is considered to be adjacent to every other net.

10. In the Find Thru-Hole Connection Info checkbox, select whether to include information
about the direction of traces that intersect through holes.

• If this option has a checkmark, ProbeMaster will include information about the direction
of traces that intersect through holes.

• If this option has no checkmark, ProbeMaster will not include information about the
direction of traces that intersect through holes. This is the recommended option.

Note: The Thru-Hole Connection Info option was used by earlier, less accurate machines, but
it is not generally necessary for newer, more accurate machines.

11. In the Additional Output  group box, select whether to incorporate an external buried resistor
file into the export file. In order for this to work, you must supply a buried resistor .DDI file
for the loaded netlist.

• If you want to incorporate an external buried resistor file into the export file, then click
the Output OHMEGA/Adj Information  option so that it has a checkmark. Then click
the Browse button and browse for the .DDI file that contains the buried resistor
information for the loaded netlist. ProbeMaster will read the .DDI file, match it to the
netlist information, and export the buried resistor information in the tester file.

• If you do not want to incorporate an external buried resistor file into the export file, then
click the Output OHMEGA/Adj Information  option so that it has no checkmark.

12. On the Output Test Files dialog, click OK .

Menu: File-Export Test

Button: None

Key: None
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Exporting Probot Test Files
To Export Probot Test Files:
1. On the File menu, click Export-Test.

2. ProbeMaster displays the Output Test Files dialog for Probot test files.

Export Probot Test File

3. Click the Browse button.

4. In the Browse dialog, browse for the file location to which you want to export the file.

5. In the File Name field, enter the name of the file you want to export.

6. On the Browse dialog, click OK .

7. In the Output Format  group box, select whether the exported data is to be in English or
Metric  units.
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8. In the Output Adjacency group box, select what type of adjacency data to export.

• All:  Outputs all adjacency data.

• Selected: Outputs adjacency for nets marked with the Selective Nets command. See
Marking Nets for Separate Export on page 186.

• Error File:  Exports a test file with no adjacency data.

9. In the Version group box, select what version of Probot test file to export.

• Version 1: Includes plane nets in adjacency file.

• Version 2: Does not include plane nets in adjacency file.

10. On the Output Test Files dialog, click OK .

Menu: File-Export Test

Button: None

Key: None
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Exporting Hummingbird Test Files
To Export Hummingbird Test Files:
1. On the File menu, click Export-Test.

2. ProbeMaster displays the Output Test Files dialog for Hummingbird test files.

Export Hummingbird Test File

3. Click the Browse button.

4. In the Browse dialog, browse for the file location to which you want to export the file.

5. In the File Name field, enter the name of the file you want to export.

6. On the Browse dialog, click OK .

7. In the Output Format  group box, select whether the exported data is to be in English or
Metric  units.
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8. The Hummingbird export operation exports test points in an IPC format netlist that contains
access flags indicating which side a hole should be accessed from. In the Drill Access group
box, select which board side to use for the access flag in the file.

• Both: Indicates access from both sides.

• CMP:  Indicates access from component side.

• SOL: Indicates access from solder side.

9. On the Output Test Files dialog, click OK .

Menu: File-Export Test

Button: None

Key: None
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Exporting AFT Test Files
To Export AFT Test Files:
1. On the File menu, click Export-Test.

2. ProbeMaster displays the Output Test Files dialog for AFT test files.

Export AFT Test File

3. Click the Browse button.

4. In the Browse dialog, browse for the file location to which you want to export the file.

5. In the File Name field, enter the name of the file you want to export.

6. On the Browse dialog, click OK .

7. In the Layers field, enter the number of layers in the PCB data.

8. On the Output Test Files dialog, click OK .

Menu: File-Export Test

Button: None

Key: None
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Exporting Probotech Test Files
To Export Probotech Test Files:
1. On the File menu, click Export-Test.

2. ProbeMaster displays the Output Test Files dialog for Probotech test files.

Export Probotech Test File

3. Click the Browse button.

4. In the Browse dialog, browse for the file location to which you want to export the file.

5. In the File Name field, enter the name of the file you want to export.

6. On the Browse dialog, click OK .

7. In the Output Format  group box, select whether the exported data is to be in English or
Metric  units.

8. On the Output Test Files dialog, click OK .

Menu: File-Export Test

Button: None

Key: None
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Exporting CAR Files
The Export CAR  command exports a generic CAR (Computer Aided Repair) file for EPC
workstations. The file will need to be processed by the EPC PreCAR software before being used on the
workstation.

To Export CAR Files:
1. On the File menu, click Export-CAR .

2. In the Browse dialog, browse for the file location to which you want to export the CAR file.

3. In the File Name field, enter the name of the file you want to export.

4. On the Browse dialog, click OK .

Menu: File-Export CAR

Button: None

Key: None
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Exporting IPC356A Files
ProbeMaster can export a subset of IPC356A.

To Export IPC356A:
1. On the File menu, click Export-IPC356A.

Export IPC356A

2. Click the Browse button.

3. Browse for the drive, folder, or network location where you want to save the files and enter
the name for the file.

4. On the Browse dialog, click OK .

5. In the Output Format  group box, select whether the exported data is to be in English or
Metric  units.

6. On the Export IPC356A dialog, click OK .

Menu: File-Export IPC356A

Button: None

Key: None
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Chapter 16
Editing PCB Data

ProbeMaster has several features for editing PCB data that has been imported into the job.

This chapter discusses PCB Editing topics which all involve changing the fundamental characteristics
of the design, not just the position of the design as a whole. Generally the PCB data imported into the
job is completely prepared in a CAM environment before importing, and this type of editing is seldom
required in ProbeMaster.

ProbeMaster also has commands for changing the position of the entire PCB design. Those commands
are discussed in Positioning the PCB on page 51.

Inserting Pads
You can insert a pad into the loaded PCB database. Because the pad that is inserted has the same D
Code and Net Number as the pad selected as the “model,” you may need to transcode the D Code or
the Net Number of the inserted pad. See Transcoding Net Numbers on page 165 and Transcoding
D Codes on page 171.

To Insert a Pad:
1. On the Edit  menu, click PCB Data-Insert Pad.

The Insert Pad tool is selected, and ProbeMaster prompts you to select an element.

2. Position the cursor near an existing pad that has the same D Code and Net Number as the pad
you want to insert.

3. Click  the mouse or press Enter.

The cursor hops to the existing pad and makes its D Code and Net Number the current values in
the Status Bar.

4. Position the cursor where you want to insert the new pad.

5. Click  the mouse or press Enter.

A new pad with the same D Code and Net Number as the selected pad is inserted at the new
location.

The Insert Pad tool remains selected until you select another tool or press the Escape key, so you
can insert one pad after another before quitting the operation.

Menu: Edit-PCB Data-Insert Pad

Button:  then 

Key: Ctrl+Shift+P
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Deleting Pads
You can delete a pad from the loaded PCB database.

To Delete Pads:
1. Position the Frame around the pads you want to delete.

2. On the Edit  menu, click PCB Data-Delete Pad.

ProbeMaster prompts whether you want to delete all pads inside the Frame.

3. Click OK .

Menu: Edit-PCB Data-Delete Pad

Button:  then 

Key: None
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Transcoding Net Numbers
The net numbers of elements are included in imported netlist data. The commands for transcoding net
numbers allow you to change the net number of a single element or an entire net.

Note: This command can be useful if you have inserted a pad. See Inserting Pads on page 163.
Because the pad that is inserted has the same Net Number as the pad selected as the “model,”
you may need to transcode the Net Number of the inserted pad.

To Transcode the Net Number of a Single Element:
1. On the Edit  menu, click PCB Data-Transcode-Trans Netcode.

Transcode Net Number of  Single Element

2. On the Trans Netcode dialog, select Single and click OK .

The Transcode Net Number tool is selected, and ProbeMaster prompts you to select an element.

3. Position the cursor near the pad for which you want to change the Net Number.

4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.
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New Net Number

6. On the Net dialog, enter the new net number, and click OK .

The pad is transcoded to the new Net Number and the entire net of that Net Number is highlighted.

The Transcode Net Number tool remains selected until you select another tool or press the
Escape key, so you can transcode the Net Number of one pad after another before quitting the
operation.

Menu: Edit-PCB Data-Transcode-Trans Netcode

Button: None

Key: Ctrl+Shift+T

To Transcode the Net Number of an Entire Net:
1. On the Edit  menu, click PCB Data-Transcode-Trans Netcode.

Transcode Net Number of Entire Net

2. On the Trans Netcode dialog, select Net, and click OK .

The Transcode Net Number tool is selected, and ProbeMaster prompts you to select an element.

3. Position the cursor near a pad in the net for which you want to change the Net Number.
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4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.

New Net Number

6. On the Net dialog, enter the new net number, and click OK .

The net containing the selected pad is transcoded to the new Net Number and the entire net is
highlighted.

The Transcode Net Number tool remains selected until you select another tool or press the
Escape key, so you can transcode the Net Number of one net after another before quitting the
operation.

Menu: Edit-PCB Data-Transcode-Trans Netcode

Button: None

Key: Ctrl+Shift+T
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Transcoding Probe Codes
The Probe Code used to probe a given pad is automatically determined by the D Code of the pad and
the D Code to Probe mapping. See Mapping D Codes to Probe Codes on page 65. However, you may
decide that some pads of a given D Code may need to be probed by a different probe than the one
mapped to that D Code. The commands to transcode Probe Codes allow you to do this.

To Transcode the Probe Code of a Single Pad:
1. On the Edit  menu, click PCB Data-Transcode-Probe Code.

Transcode Single Probe

2. On the Trans Probe dialog, select Single and click OK .

The Transcode Probe Code tool is selected, and ProbeMaster prompts you to select an element.

3. Position the cursor near the pad for which you want to change the Probe Code.

4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.
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New Probe Code

6. On the New Probe dialog, enter the new Probe Code and click OK .

The pad is transcoded to the new Probe Code.

The Transcode Probe Code tool remains selected until you select another tool or press the
Escape key, so you can transcode the Probe Code of one pad after another before quitting the
operation.

Menu: Edit-PCB Data-Transcode-Probe Code

Button: None

Key: None

To Transcode Probe Codes of a Group of Pads in the Frame:
1. Position the Frame around the pads for which you want to change the Probe Code.

2. On the Edit  menu, click PCB Data-Transcode-Probe Code.

Transcode a Group of Probes

3. On the Trans Probe dialog, select Group and click OK .

The Transcode Probe Code tool is selected, and ProbeMaster prompts you to select an element.
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4. Position the cursor near a pad that has the Probe Code you want to change.

5. Click  the mouse or press Enter.

The cursor hops to the pad and its Probe Code is displayed as the current Probe Code in the Status
Bar.

6. Click  the mouse or press Enter.

New Probe Code

7. On the New Probe dialog, enter the new Probe Code and click OK .

All pads inside the Frame that have the same Probe Code as the selected pad are transcoded to the
new Probe Code.

The Transcode Probe Code tool remains selected until you select another tool or press the
Escape key, so you can transcode the Probe Code for one group of pads in the Frame after another
before quitting the operation.

Menu: Edit-PCB Data-Transcode-Probe Code

Button: None

Key: None
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Transcoding D Codes
The D Codes of pads are included in imported PCB data, and they determine the size and shape of the
pads. The commands for transcoding D Codes allow you to change the size of a single pad or of a
group of pads inside the Frame.

Note: This command can be useful if you have inserted a pad. See Inserting Pads on page 163.
Because the pad that is inserted has the same D Code as the pad selected as the “model,” you
may need to transcode the D Code of the inserted pad.

To Transcode the D Code of a Single Pad:
1. On the Edit  menu, click PCB Data-Transcode-D Code.

Transcode D Code of a Single Pad

2. On the Trans D Code dialog, select Single and click OK .

The Transcode D Code tool is selected, and ProbeMaster prompts you to select an element.

3. Position the cursor near the pad for which you want to change the D Code.

4. Click  the mouse or press Enter.

The cursor hops to the pad.

5. Click  the mouse or press Enter.
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New D Code Size

6. On the D Code XY Size dialog, enter the dimensions of the new D Code and click OK .

The pad is transcoded to a new D Code with the new dimensions. If a different D Code with the
new dimensions already exists, that D Code is used. If a D Code with the new dimensions does not
exist, a new D Code is created with the new dimensions.

The Transcode D Code tool remains selected until you select another tool or press the Escape
key, so you can transcode the D Code of one pad after another before quitting the operation.

Menu: Edit-PCB Data-Transcode-D Code

Button:  then 

Key: Ctrl+T

To Transcode the D Codes of a Group of Pads in the Frame:
1. Position the Frame around the pads for which you want to change the D Code.

2. On the Edit  menu, click PCB Data-Transcode-D Code.

Transcode D Code of a Group of Pads

3. On the Trans D Code dialog, select Group and click OK .
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The Transcode D Code tool is selected, and ProbeMaster prompts you to select an element.

4. Position the cursor near a pad that has the D Code you want to change.

5. Click  the mouse or press Enter.

The cursor hops to the pad and its D Code is displayed as the current D Code in the Status Bar.

6. Click  the mouse or press Enter.

New D Code Size

7. On the D Code XY Size dialog, enter the dimensions of the new D Code and click OK .

All pads inside the Frame that have the same D Code as the selected pad are transcoded to a new
D Code. If a different D Code with the new dimensions already exists, that D Code is used. If a
D Code with the new dimensions does not exist, a new D Code is created with the new
dimensions.

The Transcode D Code tool remains selected until you select another tool or press the Escape
key, so you can transcode the D Code for one group of pads in the Frame after another before
quitting the operation.

Menu: Edit-PCB Data-Transcode-D Code

Button:  then 

Key: Ctrl+T
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Removing Padstacks
ProbeMaster has a command that automatically removes stacked pads in the imported PCB database.
The command identifies pads that have the same centerpoint and removes all but the largest pad. The
pads that are removed must be entirely covered by the larger pads in order to be removed. If the pads
identified are all the same size, then only one is kept.

Removing stacked pads helps to eliminate stacked test points that can cause collision errors. For more
about collision errors, see Checking for Collision Errors on page 105.

To Remove Padstacks:
� On the Action menu, click Remove Padstacks.
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Chapter 17
Printing in ProbeMaster

ProbeMaster can print the data displayed in the Viewing Area. You can preview the print job before
printing, and you can set up the paper size and orientation.

Printing the Contents of the Viewing Area
To Print the Contents of the Viewing Area:
1. Adjust the view of the data so that what you want to print is shown in the viewing area. You

can set the zoom level and the visibility settings to control what is printed.

2. On the File menu, click Print .

Print Dialog

3. In the Printer  group box, you can set options specific to your printer.

4. In the Print Range group box, the only available option is All . What is shown in the viewing
area will be printed on one page.

5. In the Copies group box, select how many copies to print.

6. Click OK .

Menu: File-Print

Button:

Key: Ctrl+P
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Previewing a Print Job
To Preview a Print Job:
1. Adjust the view of the data so that what you want to print is shown in the viewing area. You

can set the zoom level and the visibility settings to control what is printed.

2. On the File menu, click Print Preview.

Print Preview

3. If the Print Preview does not show what you want to print, click the Close button and
readjust the view and/or the Print Setup. See Setting up Paper Size and Orientation on page
178.
If the Print Preview shows what you want to print, click the Print button.
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Print Dialog

4. In the Printer  group box, you can set options specific to your printer.

5. In the Print Range group box, the only available option is All . What is shown in the viewing
area will be printed on one page.

6. In the Copies group box, select how many copies to print.

7. Click OK .

Menu: File-Print Preview

Button: None

Key: None
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Setting up Paper Size and Orientation
To Set up Paper Size and Orientation:
1. On the File menu, click Print Setup.

Print Setup Dialog

2. In the Printer  group box, you can set options specific to your printer.

3. In the Paper group box, select the paper size and source to use from those available on your
printer.

4. In the Orientation  group box select either Portrait  or Landscape.

5. Click OK .

Menu: File-Print Setup

Button: None

Key: None
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Chapter 18
Automatic Job Processing Features

The ProbeMaster/FixMaster product family has several features for automating the processing of jobs.

The AutoGen feature is an automatic processing feature within ProbeMaster (and also in FixMaster)
that automatically removes padstacks, generates test points, staggers test points, step and repeats the
PCB data, tags fiducials, exports the test files, and saves the new .JOB file. With AutoGen, you
manually load the boilerplate .JOB file, import the netlist data and start AutoGen, and if AutoGen runs
into a problem during the processing, you can intervene to fix it.

AutoFixture is the other automation feature and it is different from AutoGen. The AutoFixture product
is an upgraded version of FixMaster that has an automatic “lights out” feature that can process batches
of jobs with no intervention.

AutoGen is discussed in depth in this chapter, while AutoFixture is summarized here and discussed in
depth in the Automatic Job Processing Features chapter of the FixMaster User’s Guide. For the
summary description of AutoFixture, see AutoFixture Summary on page 182.

AutoGen
Once you have mastered the procedures for preparing jobs in ProbeMaster, you may be ready to
automate standard jobs using the ProbeMaster AutoGen Feature. AutoGen combines all the setup
dialogs in one place and automatically performs operations that you would ordinarily do manually one
at a time. You need a thorough understanding of each of the operations and dialogs available from the
AutoGen dialog to effectively use the feature.

If you frequently process similar jobs, using ProbeMaster could become as simple as loading a
boilerplate .JOB file, import the new PCB data for the new job, mapping D Codes to probes for the
new job, checking the AutoGen setup options, and clicking OK . AutoGen automatically removes
padstacks, generates test points, staggers test points, step and repeats the PCB data, tags fiducials,
exports the test files, and saves the new .JOB file. If AutoGen runs into a problem during the
processing, you can intervene to fix it.

To Process a Job Using AutoGen:
1. Open a boilerplate .JOB file. See Opening a ProbeMaster Job File on page 139.

2. Import the PCB data. See Importing PCB Files into the Job on page 145.

3. Map the D Codes to Probes by going to the Action menu and clicking D Code to Probe
Map. See Mapping D Codes to Probe Codes on page 65.

4. On the Action menu click AutoGen.

ProbeMaster displays the AutoGen Automated Features dialog. You can activate each operation
on the dialog by clicking the option so that it has a checkmark.
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AutoGen Automated Features Dialog

Most operations have corresponding setup dialogs that must be configured before the operation
can be run. To set up each operation, click on the corresponding button to display the setup dialog.
Many of these settings are stored in the boilerplate .JOB file and will not need to be changed
between jobs.

5. If you want ProbeMaster to automatically remove padstacks, click the Remove Padstacks
option so that it has a checkmark. For information on removing padstacks, see Removing
Padstacks on page 174.

6. The Assign Probes function is disabled in ProbeMaster, so do not check this option.

7. If you want ProbeMaster to automatically generate test points:

• Click the Generate option so that it has a checkmark.

• Click the Generate button.

• On the Generate Config dialog, make sure the settings are what you want. See Setting up
Test Point Generation Options on page 73.

8. If you want ProbeMaster to automatically stagger test points:
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• Click the Stagger option so that it has a checkmark.

• Click the Stagger button.

• On the Stagger Setup dialog, make sure the settings are what you want. See Staggering
Test Points on page 93.

9. If you want ProbeMaster to automatically Step and Repeat the PCB:

• Click the Step and Repeat option so that it has a checkmark.

• Click the Step and Repeat button.

• On the Step and Repeat dialog, make sure the settings are what you want. See Stepping
and Repeating the PCB on page 55.

10. If you want ProbeMaster to automatically tag fiducials, click the Find Fiducials option so
that it has a checkmark.

11. If you want ProbeMaster to automatically export the test files:

• Click the Output Test File option so that it has a checkmark.

• Click the Test File button.

• On the Output Test Files dialog, make sure the settings are what you want. See
Exporting Tester Download Files on page 152.

12. If you want ProbeMaster to automatically save the completed job:

• Click the Save New Job option so that it has a checkmark.

• Click the New Job File button.

• On the Save File dialog, browse for the drive, folder, or network location where you want
to save the file and enter the name for the file.

13. In the Layer field, select the PCB side that you want processed by AutoGen, Component
only, Solder only or Both.

14. Click OK .

ProbeMaster begins to process the job using the settings you specified. If the program encounters
a problem (such as collision errors or a bad file name) it stops and prompts for input.

Menu: Action-AutoGen

Button:

Key: None



ProbeMaster User’s Guide

182

AutoFixture Summary
The AutoFixture product has an AutoProcessing feature that automatically detects Lavenir .F04 format
netlists or Lavenir .JOB files as they are placed in a target directory and generates fixture drill files and
tester download files for them with no user intervention. You start the AutoProcessing feature and
point it at a folder containing netlists or .JOB files to be processed. AutoFixture processes the netlists
or .JOB files in the directory automatically with no intervention. For netlists, AutoFixture finds the
best fixture to use for the job, processes the job to completion, exports the tester and fixture files, and
moves on to the next netlist. For .JOB files, AutoFixture uses the fixture information saved in the files
and processes the job to completion. If AutoFixture cannot complete a particular job, it has the
capability of splitting out nets to another fixture or to a moving probe tester. Or it can save a .JOB file
to be completed by you later. When finished with one job, AutoFixture moves on to the next netlist or
.JOB file. For a full “lights-out” fixture-processing routine you can use AutoFixture’s automatic
processing along with the NetRipper.BAS script for CAMMaster. Using the two features together, the
system can take a directory full of prepared .BIN files, automatically create the netlists and then
automatically generate the fixture and tester download files. This is useful for overnight processing of
netlist and fixture files. While AutoFixture is primarily a fixturing product, it does also have the
capability of splitting nets for testing on moving probe testers and processing those split nets to
completion. For more information on AutoFixture, see AutoFixture “Lights Out” Processing in the
FixMaster User’s Guide.
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Chapter 19
Special Processing

There are some features in ProbeMaster which provide special processing unique to the needs of
certain types of testers or certain test methods.

Renumbering Nets with Unique Net Numbers
The Renumber Nets command gives new net numbers to all nets in the loaded netlist database. This
command is usually used to give unique net numbers to non-connected points. Non-connected points
often are designated by an N/C rather than a net number, or they may all have the net number 0. Some
systems (such as Probot) want all nets, including non-connected points, to have unique net number,
and the Renumber Nets command is what you use to give those non-connected points a unique net
number.

To Renumber Nets:
� On the Action menu, click Renumber Nets.

All nets are renumbered and given unique net numbers.

Menu: Action-Renumber Nets

Button: None

Key: None
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Soft Landing for MicroCraft Testers
MicroCraft testers support a feature called “soft landing” in which the tester’s probes contact pads with
less force than usual. The feature is designed to prevent small pads from being damaged by the probes.
The ProbeMaster Soft Landing feature allows you to set a size range within which pads will be tagged
as soft landing pads. The soft landing tags are included in the MicroCraft test files and the MicroCraft
testers can be set to probe those pads with less force. Once pads have been tagged as soft landing pads,
you can highlight them for inspection. For more information about highlighting soft landing pads, see
Highlighting Soft Landing Pads on page 27.

To Set up the Soft Landing Size Range:
1. On the Setup menu, click Soft Landing.

Soft Landing Dialog

2. In the SMD Min  and Max fields, enter the minimum and maximum size range you want to
use for tagging surface mount pads as soft landing pads.

3. In the Hole Min and Max fields, enter the minimum and maximum size range you want to
use for tagging through hole pads as soft landing pads.

4. Click OK .

Menu: Setup-Soft Landing

Button: None

Key: None
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SMD Both Command
The SMD Both command is generally used when you are doing combination testing with a moving
probe tester and a single-sided universal tester. In this type of testing, nets that have all surface mount
endpoints on one side of the board can be tested on the universal tester. And the only nets that need to
be tested on the moving probe are those that have surface mount endpoints on both sides of the board.
This command assures that nets with surface mount endpoints on both sides of the board have test
points on all surface mount endpoints. And the command can also be used to eliminate all other test
points.

To Use the SMD Both Command:
1. On the Action menu, click SMD Both.

SMD Both Dialog

2. On the SMD Both dialog, select whether to keep existing test points or to eliminate test points
that are not surface mount endpoints for nets with surface mount endpoints on both sides of
the board.

• If Keep Test Points has a checkmark, then all existing test points will be left alone as
ProbeMaster adds test points to surface mount endpoints for nets with surface mount
endpoints on both sides of the board.

• If Keep Test Points has no checkmark, then ProbeMaster will add test points to surface
mount endpoints for nets with surface mount endpoints on both sides of the board. And
ProbeMaster will eliminate all other test points.

3. Click OK .

Menu: Action-SMD Both

Button: None

Key: None
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Marking Nets for Separate Export
The Selective Nets command allows you to mark special nets and export test files for those nets
separate from the rest of the loaded PCB data. For instance you could use Selective Nets to mark and
test a ground plane. ProbeMaster also has a highlighting command that allows you to highlight all the
nets that have been marked with the Selective Nets command. For more information on highlighting
marked nets, see Highlighting Nets Marked with the Selective Nets Command on page 27. For
information on exporting test files for the nets marked with the Selective Nets command, see
Exporting Tester Download Files on page 152.

To Mark a Single Net:
1. On the Action menu, click Selective Netlist-Mark-Single.

ProbeMaster prompts you to select an element.

2. Click on an element in the net that you want to mark.

The cursor hops to the selected element, and the net is highlighted in magenta to indicate that it
has been marked.

The Net-Marking  tool remains selected until you select another tool or press the Escape key, so
you can mark one net after another by clicking on new elements.

Menu: Action-Selective Netlist-Mark-Single

Button: None

Key: None

To Mark a Group of Nets:
1. On the Action menu, click Selective Netlist-Mark-Group.

ProbeMaster prompts you to draw a frame.

2. Click and drag the mouse across elements in the nets that you want to mark so that you draw
a frame around those elements. Then release the mouse.

3. If the frame is positioned correctly, click the mouse or press Enter.

All nets with elements inside the frame are highlighted in magenta to indicate that they have been
marked.

The Net-Marking  tool remains selected until you select another tool or press the Escape key, so
you can mark one group of nets after another by drawing more frames.

Menu: Action-Selective Netlist-Mark-Group

Button: None

Key: None
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To Unmark a Single Net:
1. On the Action menu, click Selective Netlist-Unmark-Single.

ProbeMaster prompts you to select an element.

2. Click on an element in a net that has already been and that you want to unmark.

The cursor hops to the selected element, and the magenta highlighting is removed from the net to
indicate that it is no longer marked.

The Net-Unmarking tool remains selected until you select another tool or press the Escape key,
so you can unmark one net after another by clicking on new elements.

Menu: Action-Selective Netlist-Unmark-Single

Button: None

Key: None

To Unmark a Group of Nets:
1. On the Action menu, click Selective Netlist-Unmark-Group.

ProbeMaster prompts you to draw a frame.

2. Click and drag the mouse across elements in the marked nets that you want to unmark so that
you draw a frame around those elements. Then release the mouse.

3. If the frame is positioned correctly, click the mouse or press Enter.

The magenta highlighting is removed from all nets with elements inside the frame to indicate that
they are now unmarked.

The Net-Unmarking tool remains selected until you select another tool or press the Escape key,
so you can unmark one group of nets after another by drawing more frames.

Menu: Action-Selective Netlist-Unmark-Group

Button: None

Key: None
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Chapter 20
Key Commands Summary

In ProbeMaster, many menu and toolbar commands have shortcut key equivalents, and some
commands are only activated by key commands. Shortcut key commands are usually the fastest way to
activate commands. In addition, all menu commands can be accessed using access key commands,
which are an alternative way of working the command menus. See Access Keys for Menu Commands
on page 8.

This chapter lists the shortcut key commands.

File Commands
Start a New ProbeMaster Job Ctrl+N

Open a ProbeMaster Job Ctrl+O

Save a ProbeMaster Job Ctrl+S

Displaying Data
Display Component Side or Solder Side Data Shift+O

Display the PCB Data B

Display All Pads or Only Pads with Test Points Shift+P

Display Net Numbers F

Display Traces (Dialog) T

Display Traces (Toggle) Shift+T

Display Silkscreen Data K

Display Board Outline Data O

Show Job Statistics F6

Highlighting Data
Highlight a Specific Netlist Shift+F

Highlight Data by D Code Ctrl+D

Highlight Tooling Holes Shift+E

Highlight Data by Probe Code Shift+B

Remove Highlighting from the Screen Shift+H
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Zooming
Zoom Up or Down Page Up or Page Down

Zoom so that All Data is Shown on Screen Home

Zoom on the Reference Frame W

Zoom to a Specific Zoom Level Z

Going to Locations on Screen
Move the Cursor Arrow Keys

Go to Specific X, Y Coordinates X or Y

Select a Pad or Test Point S

Go to the Last Selected Test Point Ctrl+H

Go to the Next Highlighted Element N

Screen Grid
Turn the Screen Grid On or Off G

Anchored or Dragged Grid Shift+G

Fixed or Variable Grid Ctrl+G

Measuring Distance
Measure Distance with Distance Measure Mode D

Measure Distance with the Relative Origin R

Reference Frame
Draw a New Reference Frame Shift+W

Insert Reference Frame Around All Data Ctrl+W

Mapping D Codes to Probes
Map D Codes to Probe F5

Inserting Test Points
Insert Single Test Point Shift+I
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Staggering Test Points
Stagger All Test Points Automatically Ctrl+Shift+F9

Manually Stagger Individual Test Points Shift+F9

Swap the Stagger Position of Staggered Points Ctrl+F9

Netlist Inspection Mode
Display the First Net Shift+F

Display the Next Net Shift+N

Display the Previous Net Shift+B

Select a Pad or Test Point S

Editing PCB Data
Insert Pad Ctrl+Shift+P

Transcode Net Numbers Ctrl+Shift+T

Transcode D Codes Ctrl+T



ProbeMaster User’s Guide

192



193

Index

A
About ProbeMaster for Windows, 1
Acccessed Side

Displaying Only the Accessed Side for IPC-D-356
Pads with Access Data, 17

Access Keys
Key Commands Overview, 14

Action Toolbar, 10
Active Board Side

Displaying Component Side or Solder Side Data, 15
Switching the Active Board Side in Adjacency

Inspection Mode, 128
Switching the Active Board Side in Netlist Inspection

Mode, 120
Add Test Points Overview, 71
Adjacency

Adjacency Inspection Mode Overview, 125
Adjacency Inspection Toolbar, 125
Checking Nets for Adjacency, 123
Displaying a Specific Adjacency in Adjacency

Inspection Mode, 127
Displaying the First, Next or Previous Adjacency in

the File in Adjacency Inspection Mode, 128
Entering and Exiting Adjacency Inspection Mode, 126
Net Adjacency Overview, 123
Switching the Active Board Side in Adjacency

Inspection Mode, 128
AFT

Exporting AFT Test Files, 158
Anchored or Dragged Grid, 38
Application Window, 7
AutoFixture

AutoFixture Summary, 182
Automatic Processing Overview, 179

AutoGen
AutoGen Procedure, 179
Automatic Processing Overview, 179

Automation
AutoFixture Summary, 182
AutoGen Procedure, 179
Automatic Processing Overview, 179

B
Barrel Optimize

Through-Hole Test Points on Opposite Board Side
from Incoming Trace, 76

Black Box
AutoFixture Summary, 182
Automatic Processing Overview, 179

Board Outline
Displaying Board Outline Data, 20
Importing Supplemental Gerber Files into the Job, 150

Board Side
All Through-Hole Test Points on One Board Side, 75
Displaying Component Side or Solder Side Data, 15
Equal Number of Through-Hole Test Points Per

Board Side, 74
Switching the Active Board Side in Adjacency

Inspection Mode, 128
Switching the Active Board Side in Netlist Inspection

Mode, 120
Transferring Test Point to other Side of Board, 91

Boilerplate Jobs
ProbeMaster Job File (.JOB) Overview, 137

C
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Combination Testing
SMD Both Command, 185

Command Menus, 8
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Commands
Key Commands Overview, 14
Key Commands Summary List, 189
ProbeMaster Interface Overview, 7

Commented Pads
Displaying "Commented" Pads in IPC- D-356 Data,

16
Component Side

All Through-Hole Test Points on One Board Side, 75
Displaying Component Side or Solder Side Data, 15
Switching the Active Board Side in Adjacency

Inspection Mode, 128
Switching the Active Board Side in Netlist Inspection

Mode, 120
Convert

Converting Netlist Files to Lavenir Format, 148
Coordinates

Going to Specific X Y Coordinates, 33
Using the Relative Origin, 44

Correcting Collision Errors, 107
Covered Pads

Going to Possibly Probeable Pads not Given Test
Points, 36

Possibly Probeable, Possibly Covered Test Points, 80
Curosr

Moving the Cursor Manually, 32

D
D Codes

D Code to Probe Mapping Table, 66
Highlighting Data by D Code, 25
Manually Map D Codes to Probe Codes, 68
Map D Codes to Probe Codes Overview, 65
Transcoding D Codes, 171

Delete
Deleting Pads, 164
Deleting Test Points, 86
Deleting Test Points in Netlist Inspection Mode, 121

Densly Packed Component
Testing Densely Packed Components Separately, 133

Design Rule Errors
Checking for Collision Errors Overview, 105
Correcting Collision Errors, 107
Inspecting Collision Errors, 106
Possibly Probeable, Possibly Covered Test Points, 80
Removing Padstacks, 174
Running a Collision Check on the Whole PCB, 105

Display
Choosing What Data to Display, 15

Displaying "Commented" Pads in IPC- D-356 Data,
16

Displaying a Specific Adjacency in Adjacency
Inspection Mode, 127

Displaying a Specific Net in Netlist Inspection Mode,
112

Displaying All Pads or Only Pads with Test Points, 16
Displaying Board Outline Data, 20
Displaying Component Side or Solder Side Data, 15
Displaying Net Numbers, 17
Displaying Nets in Netlist Inspection Mode, 112
Displaying Nets that Do Not Have Enough Test Points

in Netlist Inspection Mode, 114
Displaying Only the Accessed Side for IPC-D-356

Pads with Access Data, 17
Displaying Silkscreen Data, 19
Displaying Soldermask Data, 19
Displaying Statistical Information Overview, 41
Displaying Test Point Numbers, 20
Displaying Test Points with a Large X in Netlist

Inspection Mode, 116
Displaying the Fiducials, 21
Displaying the First, Next or Previous Adjacency in

the File in Adjacency Inspection Mode, 128
Displaying the First, Next or Previous Net in the File

in Netlist Inspection Mode, 113
Displaying the PCB Data, 15
Displaying Traces, 18
Going to the Next Highlighted Element, 34
Showing Everything in Gray Except for the

Highlighted Elements, 22
Showing the Job Statistics, 42
Showing the Pad and Trace Counts for each Net, 41
Viewing Data in ProbeMaster Overview, 15
Visibility Toolbar, 13

Distance Measurement
Distance Measurement Overview, 43
Using Distance Measurement Mode, 43
Using the Relative Origin, 44

Download
Download ProbeMaster Updates, 4

Dragged or Anchored Grid, 38

E
Edit

Editing Test Points Manually, 81
Edit PCB Data Overview, 163
Editing Mode Toolbar, 11
Editing Toolbar, 10
Emma
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Exporting MicroCraft MP-440 and Emma Test Files,
152

Soft Landing for MicroCraft Testers, 184
Endpoints

Surface-Mount Pads - Test Points for Endpoints Only,
78

Through-Hole Pads - Test Points for Endpoints Only,
79

Vias - Test Points for Endpoints Only, 79
English or Metric Units, 45
Entering and Exiting Adjacency Inspection Mode, 126
Entering and Exiting Netlist Inspection Mode, 111
Equal Number of Through-Hole Test Points Per Board

Side, 74
Errors

Checking for Collision Errors Overview, 105
Correcting Collision Errors, 107
Going to Collision Errors, 36
Going to Possibly Probeable Pads not Given Test

Points, 36
Inspecting Collision Errors, 106
Possibly Probeable, Possibly Covered Test Points, 80
Removing Padstacks, 174
Running a Collision Check on the Whole PCB, 105

Export
Exporting AFT Test Files, 158
Exporting CAR Files, 160
Exporting Hummingbird Test Files, 156
Exporting IPC356A, 161
Exporting MicroCraft MP-440 and Emma Test Files,

152
Exporting Probot Test Files, 154
Exporting Probotech Test Files, 159
Exporting Tester Download Files Overview, 152
File Handling in ProbeMaster Overview, 137
Marking Nets for Separate Export, 186

F
Feedback

Send Us Your Comments, 3
Fiducials

Displaying the Fiducials, 21, 132
Elements to Use as Fiducials, 129
Fiducial Points Overview, 129
Tagging the Fiducials, 130

Files
Closing a ProbeMaster Job File, 141
Converting Netlist Files to Lavenir Format, 148
Exporting AFT Test Files, 158
Exporting CAR Files, 160

Exporting Hummingbird Test Files, 156
Exporting IPC356A, 161
Exporting MicroCraft MP-440 and Emma Test Files,

152
Exporting Probot Test Files, 154
Exporting Probotech Test Files, 159
Exporting Tester Download Files Overview, 152
File Handling in ProbeMaster Overview, 137
Importing IPC-D-356 Formatted Netlist Files into the

Job, 145
Importing PCB Files into the Job Overview, 145
Importing Supplemental Gerber Files into the Job, 150
Opening a ProbeMaster Job File, 139
ProbeMaster Job File (.JOB) Overview, 137
Saving a Job File, 142
Starting a New ProbeMaster Job, 138

Fixed or Variable Grid, 39
FixMaster

ProbeMaster Job File (.JOB) Overview, 137
Flip

Mirroring the PCB, 51
Frame

Automatic Zoom-on-Frame Feature, 30
Drawing a New Reference Frame, 46
Inserting a Reference Frame around All Data, 46
Using the Reference Frame Overview, 46
Window Stagger with Margin, 103
Zooming on the Reference Frame, 30

G
Generate Test Points

All Through-Hole Test Points on One Board Side, 75
Balanced Through-Holes, 74
Component Side Through-Holes Only, 75
Equal Number of Through-Hole Test Points Per

Board Side, 74
Generating Test Points Procedure, 71
No Test Points Covered by Gerber Silkscreen, 77
No Test Points Covered by Gerber Soldermask, 77
No Test Points for Pads with IPC Soldermask Flags,

79
One Test Point Per Net, 74
Surface-Mount Pads - Test Points for Endpoints Only,

78
Test Points for Single-Point Nets, 73
Test Points for Vias, 79
Through-Hole Pads - Test Points for Endpoints Only,

79
Through-Hole Test Points on Opposite Board Side

from Incoming Trace, 76
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Vias - Test Points for Endpoints Only, 79
Gerber

Importing Supplemental Gerber Files into the Job, 150
Go to

Moving the Cursor Manually, 32
Go To

Going to a Test Point Number, 35
Going to Collision Errors, 36
Going to Possibly Probeable Pads not Given Test

Points, 36
Going to Specific Locations on Screen, 32
Going to Specific X Y Coordinates, 33
Going to the Last Selected Test Point, 34
Going to the Next Highlighted Element, 34
Goto Toolbar, 11
Inspecting Collision Errors, 106

Gray
Showing Everything in Gray Except for the

Highlighted Elements, 22
Grid

Anchored or Dragged Grid, 38
Fixed or Variable Grid, 39
Grid Units, 40
Turning the Screen Grid On or Off, 37
Using the Screen Grid, 37

Ground Plane Nets
Identifying Power and Ground Plane Nets, 63

H
Highlight

Going to the Next Highlighted Element, 34
Highlighting a Specific Net, 23
Highlighting Data by D Code, 25
Highlighting Data by Probe Code, 26
Highlighting Data on Screen Overview, 22
Highlighting Selective Nets, 27
Highlighting Soft Landing Pads, 27
Highlighting the Net of a Selected Element, 24
Highlighting Tooling Holes, 25
HiLite Toolbar, 12
Removing Highlighting from the Screen, 28
Showing Everything in Gray Except for the

Highlighted Elements, 22
Hotkeys

Key Commands Overview, 14
Key Commands Summary List, 189

How to Process a Job Using ProbeMaster, 5
Hummingbird

Exporting Hummingbird Test Files, 156

I
Impedance Testing

Identifying Power and Ground Plane Nets, 63
Import

Converting Netlist Files to Lavenir Format, 148
File Handling in ProbeMaster Overview, 137
Importing IPC-D-356 Formatted Netlist Files into the

Job, 145
Importing PCB Files into the Job Overview, 145
Importing Supplemental Gerber Files into the Job, 150

Inches or Millimeters, 45
Insert

Inserting Pads, 163
Inserting Test Points, 81
Inserting Test Points in Netlist Inspection Mode, 120

Interface
Action Toolbar, 10
Adjacency Inspection Toolbar, 125
Application Window, 7
Command Menus, 8
Command Toolbars, 9
Editing Mode Toolbar, 11
Editing Toolbar, 10
Goto Toolbar, 11
HiLite Toolbar, 12
Key Commands Overview, 14
Main Toolbar, 9
Netlist Inspection Toolbar, 109
ProbeMaster Interface Overview, 7
Screen Toolbar, 12
Status Bar, 13
Visibility Toolbar, 13

IPC356A
Exporting IPC356A, 161

IPC-D-356
Importing IPC-D-356 Formatted Netlist Files into the

Job, 145
Iso Component Generate

Testing Densely Packed Components Separately, 133

J
Job File

Closing a ProbeMaster Job File, 141
Opening a ProbeMaster Job File, 139
ProbeMaster Job File (.JOB) Overview, 137
Saving a Job File, 142
Starting a New ProbeMaster Job, 138

Job Statistics
Displaying Statistical Information Overview, 41
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Showing the Job Statistics, 42
Showing the Pad and Trace Counts for each Net, 41

K
Key Commands

Key Commands Overview, 14
Key Commands Summary List, 189
ProbeMaster Interface Overview, 7

L
Lavenir

Send Us Your Comments, 3
Lavenir Format

Converting Netlist Files to Lavenir Format, 148
Lavenir Technical Support, 4
Lights Out

AutoFixture Summary, 182
Automatic Processing  Overview, 179

M
Main Toolbar, 9
Map D Codes to Probes

D Code to Probe Mapping Table, 66
Manually Map D Codes to Probe Codes, 68
Map D Codes to Probe Codes Overview, 65

Measure Distance
Distance Measurement Overview, 43
Using Distance Measurement Mode, 43
Using the Relative Origin, 44

Menus
Command Menus, 8
ProbeMaster Interface Overview, 7

Metric or English Units, 45
MicroCraft

Exporting MicroCraft MP-440 and Emma Test Files,
152

Soft Landing for MicroCraft Testers, 184
Millimeters or Inches, 45
Mirror

Mirroring the PCB, 51
Mouse

Moving the Cursor Manually, 32
Move

Moving the Cursor Manually, 32
Moving the PCB, 52

N
Net Adjacency

Adjacency Inspection Mode Overview, 125
Adjacency Inspection Toolbar, 125
Checking Nets for Adjacency, 123
Displaying a Specific Adjacency in Adjacency

Inspection Mode, 127
Displaying the First, Next or Previous Adjacency in

the File in Adjacency Inspection Mode, 128
Entering and Exiting Adjacency Inspection Mode, 126
Net Adjacency Overview, 123
Switching the Active Board Side in Adjacency

Inspection Mode, 128
Netlist

Converting Netlist Files to Lavenir Format, 148
Displaying Net Numbers, 17
Highlighting a Specific Net, 23
Highlighting the Net of a Selected Element, 24
Identifying Power and Ground Plane Nets, 63
Importing IPC-D-356 Formatted Netlist Files into the

Job, 145
Renumbering Nets with Unique Net Numbers, 183
Showing the Pad and Trace Counts for each Net, 41
Transcoding Net Numbers, 165

Netlist Inspection Mode
Adding Test Points to Nets that Do Not Have Enough

Test Points in Netlist Inspection Mode, 121
Color System in Netlist Inspection Mode, 110
Deleting Test Points in Netlist Inspection Mode, 121
Displaying a Specific Net in Netlist Inspection Mode,

112
Displaying Nets in Netlist Inspection Mode, 112
Displaying Nets that Do Not Have Enough Test Points

in Netlist Inspection Mode, 114
Displaying Test Points with a Large X in Netlist

Inspection Mode, 116
Displaying the First, Next or Previous Net in the File

in Netlist Inspection Mode, 113
Editing Test Points in Netlist Inspection Mode, 120
Entering and Exiting Netlist Inspection Mode, 111
Inserting Test Points in Netlist Inspection Mode, 120
Inspecting Ring Nets, 118
Netlist Inspection Mode Overview, 109
Netlist Inspection Toolbar, 109
Selecting a Test Point or Pad in Netlist Inspection

Mode, 120
Switching the Active Board Side in Netlist Inspection

Mode, 120
New Features

What's New in ProbeMaster 7.5 for Windows, 3
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New Job
Starting a New ProbeMaster Job, 138

No TP Nets
Displaying Nets that Do Not Have Enough Test Points

in Netlist Inspection Mode, 114
Non-Coded Step and Repeat, 55
Numbering

Renumbering Nets with Unique Net Numbers, 183

O
One Test Point Per Net, 74
Opening a ProbeMaster Job File, 139
Origin

Using the Relative Origin, 44
Outline

How to Process a Job Using ProbeMaster, 5
Overview

How to Process a Job Using ProbeMaster, 5

P
Pads

Deleting Pads, 164
Inserting Pads, 163
Possibly Probeable, Possibly Covered Test Points, 80
Removing Padstacks, 174
Selecting a Test Point or Pad, 33
Selecting a Test Point or Pad in Netlist Inspection

Mode, 120
Showing the Pad and Trace Counts for each Net, 41
Transcoding D Codes, 171

Padstacks
Removing Padstacks, 174

PCB Data
Coded Step and Repeat, 57
Deleting Pads, 164
Displaying the PCB Data, 15
Editing PCB Data Overview, 163
Importing PCB Files into the Job Overview, 145
Inserting Pads, 163
Mirroring the PCB, 51
Moving the PCB, 52
Non-Coded Step and Repeat, 55
Position the PCB Overview, 51
Removing Padstacks, 174
Rotating the PCB, 53
Selecting a Test Point or Pad, 33
Selecting a Test Point or Pad in Netlist Inspection

Mode, 120

Stepping and Repeating the PCB Overview, 55
Transcoding D Codes, 171
Transcoding Net Numbers, 165

Phase Difference Testing
Identifying Power and Ground Plane Nets, 63

Place PCB
Position the PCB Overview, 51

Plane Nets
Identifying Power and Ground Plane Nets, 63

Position the PCB Overview, 51
Power Plane Nets

Identifying Power and Ground Plane Nets, 63
Printing

Previewing a Print Job, 176
Printing in ProbeMaster Overview, 175
Printing the Contents of the Viewing Area, 175
Setting up Paper Size and Orientation, 178

Probe? Errors
Going to Possibly Probeable Pads not Given Test

Points, 36
Possibly Probeable, Possibly Covered Test Points, 80

Probes
D Code to Probe Mapping Table, 66
Highlighting Data by Probe Code, 26
Manually Map D Codes to Probe Codes, 68
Map D Codes to Probe Codes Overview, 65
Setting up the Probes, 49
Transcoding Probe Codes, 168

Probot
Exporting Probot Test Files, 154
Renumbering Nets with Unique Net Numbers, 183

Probotech
Exporting Probotech Test Files, 159

Procedure
How to Process a Job Using ProbeMaster, 5

R
Reference Frame

Automatic Zoom-on-Frame Feature, 30
Drawing a New Reference Frame, 46
Inserting a Reference Frame around All Data, 46
Using the Reference Frame Overview, 46
Window Stagger with Margin, 103
Zooming on the Reference Frame, 30

Relative Origin
Using the Relative Origin, 44

Removing Highlighting from the Screen, 28
Removing Padstacks, 174
Renumbering Nets with Unique Net Numbers, 183
Ring Nets
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Inspecting Ring Nets, 118
Rotate

Rotating the PCB, 53

S
Saving a Job File, 142
Screen Grid

Anchored or Dragged Grid, 38
Fixed or Variable Grid, 39
Grid Units, 40
Turning the Screen Grid On or Off, 37
Using the Screen Grid, 37

Screen Toolbar, 12
Select

Going to the Last Selected Test Point, 34
Selecting a Test Point or Pad, 33
Selecting a Test Point or Pad in Netlist Inspection

Mode, 120
Selective Nets

Highlighting Selective Nets, 27
Marking Nets for Separate Export, 186

Send Us Your Comments, 3
Shortcut Keys

Key Commands Overview, 14
Key Commands Summary List, 189

Show
Choosing What Data to Display, 15
Displaying "Commented" Pads in IPC- D-356 Data,

16
Displaying a Specific Adjacency in Adjacency

Inspection Mode, 127
Displaying a Specific Net, 112
Displaying All Pads or Only Pads with Test Points, 16
Displaying Board Outline Data, 20
Displaying Component Side or Solder Side Data, 15
Displaying Net Numbers, 17
Displaying Nets in Netlist Inspection Mode, 112
Displaying Nets that Do Not Have Enough Test Points

in Netlist Inspection Mode, 114
Displaying Only the Accessed Side for IPC-D-356

Pads with Access Data, 17
Displaying Silkscreen Data, 19
Displaying Soldermask Data, 19
Displaying Statistical Information Overview, 41
Displaying Test Point Numbers, 20
Displaying Test Points with a Large X in Netlist

Inspection Mode, 116
Displaying the Fiducials, 21
Displaying the First, Next or Previous Adjacency in

the File in Adjacency Inspection Mode, 128

Displaying the First, Next or Previous Net in the File
in Netlist Inspection Mode, 113

Displaying the PCB Data, 15
Displaying Traces, 18
Going to the Next Highlighted Element, 34
Showing Everything in Gray Except for the

Highlighted Elements, 22
Showing the Job Statistics, 42
Showing the Pad and Trace Counts for each Net, 41
Viewing Data in ProbeMaster Overview, 15
Visibility Toolbar, 13
Zooming to Show All Data, 29

Silkscreen
Displaying Silkscreen Data, 19
Going to Possibly Probeable Pads not Given Test

Points, 36
Importing Supplemental Gerber Files into the Job, 150
No Test Points Covered by Gerber Silkscreen, 77
Possibly Probeable, Possibly Covered Test Points, 80

Single-Point Nets
Test Points for Single-Point Nets, 73

SMD Both Command, 185
Soft Landing

Highlighting Soft Landing Pads, 27
Soft Landing for MicroCraft Testers, 184
Software Updates

Download ProbeMaster Updates, 4
SOL

Displaying Component Side or Solder Side Data, 15
Switching the Active Board Side in Adjacency

Inspection Mode, 128
Switching the Active Board Side in Netlist Inspection

Mode, 120
Solder Side

All Through-Hole Test Points on One Board Side, 75
Displaying Component Side or Solder Side Data, 15
Switching the Active Board Side in Adjacency

Inspection Mode, 128
Switching the Active Board Side in Netlist Inspection

Mode, 120
Soldermask

Displaying Soldermask Data, 19
Going to Possibly Probeable Pads not Given Test

Points, 36
Importing Supplemental Gerber Files into the Job, 150
No Test Points Covered by Gerber Soldermask, 77
No Test Points for Pads with IPC Soldermask Flags,

79
Possibly Probeable, Possibly Covered Test Points, 80

Split Net
Testing Densely Packed Components Separately, 133
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Stagger
Manually Staggering Individual Test Points, 100
Staggering All Test Points Automatically, 98
Staggering Test Points in the Frame, 101
Staggerring Test Points Overview, 93
Swapping the Stagger Position of Staggered Points in

the Frame, 102
Window Stagger with Margin, 103

Starting a New ProbeMaster Job, 138
Statistics

Displaying Statistical Information Overview, 41
Showing the Job Statistics, 42
Showing the Pad and Trace Counts for each Net, 41

Status Bar, 13
Step and Repeat

Coded Step and Repeat, 57
Non-Coded Step and Repeat, 55
Stepping and Repeating the PCB Overview, 55

Support
Lavenir Technical Support, 4

Surface-Mount Pads
Staggerring Test Points, 93
Surface-Mount Pads - Test Points for Endpoints Only,

78
Swap

Swapping the Stagger Position of Staggered Points in
the Frame, 102

T
Technical Support, 4
Test Point Numbers

Displaying Test Point Numbers, 20
Going to a Test Point Number, 35

Test Points
Add Test Points Overview, 71
Adding Test Points to Nets that Do Not Have Enough

Test Points in Netlist Inspection Mode, 121
All Through-Hole Test Points on One Board Side, 75
Deleting Test Points, 86
Deleting Test Points in Netlist Inspection Mode, 121
Displaying All Pads or Only Pads with Test Points, 16
Editing Test Points in Netlist Inspection Mode, 120
Editing Test Points Manually, 81
Equal Number of Through-Hole Test Points Per

Board Side, 74
Generating Test Points Procedure, 71
Going to Possibly Probeable Pads not Given Test

Points, 36
Going to the Last Selected Test Point, 34
Inserting Test Points, 81

Inserting Test Points in Netlist Inspection Mode, 120
Manually Staggering Individual Test Points, 100
No Test Points Covered by Gerber Silkscreen, 77
No Test Points Covered by Gerber Soldermask, 77
No Test Points for Pads with IPC Soldermask Flags,

79
One Test Point Per Net, 74
Possibly Probeable, Possibly Covered Test Points, 80
Selecting a Test Point or Pad, 33
Selecting a Test Point or Pad in Netlist Inspection

Mode, 120
Staggering All Test Points Automatically, 98
Staggering Test Points in the Frame, 101
Staggerring Test Points Overview, 93
Surface-Mount Pads - Test Points for Endpoints Only,

78
Swapping the Stagger Position of Staggered Points in

the Frame, 102
Test Points for Single-Point Nets, 73
Test Points for Vias, 79
Through-Hole Pads - Test Points for Endpoints Only,

79
Through-Hole Test Points on Opposite Board Side

from Incoming Trace, 76
Transferring Test Point to other Side of Board, 91
Vias - Test Points for Endpoints Only, 79
Window Stagger with Margin, 103

Tester Configuration
Selecting the Tester Type, 47
Setting up the Probes, 49
Setting up the Tester Configuration Overview, 47
Using Boilerplate Jobs, 47

Tester Files
Exporting AFT Test Files, 158
Exporting CAR Files, 160
Exporting Hummingbird Test Files, 156
Exporting MicroCraft MP-440 and Emma Test Files,

152
Exporting Probot Test Files, 154
Exporting Probotech Test Files, 159
Exporting Tester Download Files Overview, 152

Through-Hole Pads
All Through-Hole Test Points on One Board Side, 75
Equal Number of Through-Hole Test Points Per

Board Side, 74
Staggerring Test Points, 93
Through-Hole Pads - Test Points for Endpoints Only,

79
Through-Hole Test Points on Opposite Board Side

from Incoming Trace, 76
Toolbar
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Action Toolbar, 10
Adjacency Inspection Toolbar, 125
Application Window, 7
Command Toolbars, 9
Editing Mode Toolbar, 11
Editing Toolbar, 10
Goto Toolbar, 11
HiLite Toolbar, 12
Main Toolbar, 9
Netlist Inspection Toolbar, 109
ProbeMaster Interface Overview, 7
Screen Toolbar, 12
Status Bar, 13
Visibility Toolbar, 13

Tooling Holes
Highlighting Tooling Holes, 25

Traces
Displaying Traces, 18
Showing the Pad and Trace Counts for each Net, 41

Transcode
Transcoding D Codes, 171
Transcoding Net Numbers, 165
Transcoding Probe Codes, 168

Transfer
Transferring Test Point to other Side of Board, 91

U
Unique Net Numbers

Renumbering Nets with Unique Net Numbers, 183
Update

Download ProbeMaster Updates, 4
What's New in ProbeMaster 7.5 for Windows, 3

V
Variable or Fixed Grid, 39
Verify

ProbeMaster Job File (.JOB) Overview, 137
Vias

Test Points for Vias, 79
Vias - Test Points for Endpoints Only, 79

View
Choosing What Data to Display, 15
Displaying "Commented" Pads in IPC- D-356 Data,

16
Displaying a Specific Adjacency in Adjacency

Inspection Mode, 127
Displaying a Specific Net in Netlist Inspection Mode,

112

Displaying All Pads or Only Pads with Test Points, 16
Displaying Board Outline Data, 20
Displaying Component Side or Solder Side Data, 15
Displaying Net Numbers, 17
Displaying Nets in Netlist Inspection Mode, 112
Displaying Nets that Do Not Have Enough Test Points

in Netlist Inspection Mode, 114
Displaying Only the Accessed Side for IPC-D-356

Pads with Access Data, 17
Displaying Silkscreen Data, 19
Displaying Soldermask Data, 19
Displaying Test Point Numbers, 20
Displaying Test Points with a Large X in Netlist

Inspection Mode, 116
Displaying the Fiducials, 21
Displaying the First, Next or Previous Adjacency in

the File in Adjacency Inspection Mode, 128
Displaying the First, Next or Previous Net in the File

in Netlist Inspection Mode, 113
Displaying the PCB Data, 15
Displaying Traces, 18
Going to the Next Highlighted Element, 34
Showing Everything in Gray Except for the

Highlighted Elements, 22
Viewing Data in ProbeMaster Overview, 15
Visibility Toolbar, 13

Visibility Toolbar, 13

W
What's New

What's New in ProbeMaster 7.5 for Windows, 3
Window

Automatic Zoom-on-Frame Feature, 30
Drawing a New Reference Frame, 46
Inserting a Reference Frame around All Data, 46
Using the Reference Frame Overview, 46
Window Stagger with Margin, 103
Zooming on the Reference Frame, 30

X
X Y Coordinates

Going to Specific X Y Coordinates, 33

Z
Zoom

Automatic Zoom-on-Frame Feature, 30
Zooming on Data Overview, 29
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Zooming on the Reference Frame, 30
Zooming to a Specific Zoom Level, 31
Zooming to Show All Data, 29
Zooming Up or Down in Steps, 29


